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1. INTRODUCTION 

The thermophysical properties of water are of interest in many industrial and research applications. Official 
international formulations for water properties are developed and maintained by the International Association 
for the Properties of Water and Steam (IAPWS). The U.S. national committee for IAPWS is the Properties 
Subcommittee of the Research and Technology Committee on Water and Steam in Thermal Systems of the 
American Society of Mechanical Engineers (ASME). In 1995, IAPWS adopted a new formulation for general 
and scientific use for the thermodynamic properties of water, U.S. rights to which were assigned to the U.S. 
national committee. NIST has taken the responsibility of putting this formulation, along with those for other 
water properties, into a software implementation. The resulting NIST/ASME STEAM Properties Database, 
NIST Standard Reference Database 10, provides water properties in a user-friendly manner over a wide 
range of conditions. The formulations used to compute all the properties are those adopted by IAPWS (see 
Appendix A). More information on these formulations may be found at www.iapws.org. 

The IAPWS water/steam property models are implemented in a suite of FORTRAN subroutines. They are 
written in a structured format, are internally documented with extensive comments, and have been tested on 
a variety of compilers. Routines are provided to calculate thermodynamic and transport properties at a given 
(T,ρ) state. Iterative routines provide properties for saturation at specified T or P, and properties of single- or 
two-phase states with other combinations of independent variables such as (P,h) and (T,P). 

A separate graphical user interface, designed for the Windows operating system, provides a convenient 
means of accessing the models. It generates tables and plots of calculated properties. Numerous options to 
customize the output are available as well as capabilities to copy and paste to and from other applications. 

The property models can also be accessed by other applications (such as spreadsheets) through use of a 
dynamic link library (DLL). 

The formulation for thermodynamic properties implemented here should not be confused with the separate 
"Industrial Formulation" (known as IAPWS-IF97) adopted by IAPWS in 1997.  IAPWS-IF97 is designed 
specifically for use in the steam power industry; it is slightly less accurate than the formulation used here, but 
is computationally faster. In the U.S., software implementing IAPWS-IF97 is distributed by the ASME; further 
information may be obtained by contacting them at infocentral@asme.org. 
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2. INSTALLATION 

2.1 System Requirements 

STEAM is designed to run on any personal computer running the Microsoft® Windows® 98, 2000, XP, Vista, 
Windows 7 or similar operating system. The program requires 20 MB of hard disk space. 

2.2 Installation 

Place the STEAM CD-ROM in the CD drive. Click [START], select [RUN] type in: D:\NIST10v3, or whichever 
driver letter is associated with your CD reader. Follow the remainder of the installation instructions.  By 
default, STEAM is installed in the C:\Program Files\NIST\STEAM directory, but this can be changed by the 
user at installation.  The user is cautioned to not change the names of the various files and subdirectories 
that are installed. 
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3. OVERVIEW 

This section presents a brief overview of the program and its main features. Please refer to the remaining 
sections in this User's Guide for more complete information. 

3.1 Database Structure 

STEAM consists of a graphical user interface (GUI) and FORTRAN subroutines implementing its property 
models. The interface provides a convenient means to calculate and display properties. The property models 
are written in FORTRAN and accessed by the GUI through a dynamic link library (DLL). The property 
subroutines can also be used by other applications, such as spreadsheets, independently of the GUI, as 
described in Appendix B. 

3.2 Use of the Database 

Start the STEAM program by double-clicking on its icon. A banner screen displays the title, credits, and a 
legal disclaimer. Clicking the "Information" button calls up further details and credits through the help system. 
Clicking the "Continue" button starts the program. The program is controlled, in the usual fashion of a 
Windows application, by the use of pull-down menus displayed across the top of the application window. 

 

3.3 Overview of the Menus 

The File menu provides commands to save and print generated tables and plots. Individual items or entire 
sessions with multiple windows can be saved or recalled. The standard Print, Print Setup, and Exit 
commands are also present. 

The Edit menu provides copy and paste commands, which allow selected data or plots to be exchanged with 
other applications.  

The Options menu provides commands for selecting the unit system, properties of interest, and user 
preferences. These options can be stored for recall. A user-defined set of preferences is loaded upon 
program startup. 

The Calculate menu initiates the calculations that generate a property table. Each property selected for 
display is shown in a separate column of the table. Two types of tables are provided. The first provides 
properties either at saturation or with a property (such as density or enthalpy) held constant with temperature 
or pressure varying over a specified range. The second allows the user to select the independent variables. 
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Values of the independent variables can be entered with the keyboard, read from a file, or pasted from 
another application.  

The Plot menu provides x-y plots of properties appearing in a table. In addition, simple plots of the 
thermodynamic surface can be easily generated over a wide range of coordinates, including temperature-
entropy and pressure-enthalpy. Commands are provided to modify the plot size, axis scaling, plot symbols, 
line type, legend, and other plot features.  

Each table or plot appears in a separate window and can be accessed, resized, or retitled with commands in 
the Window menu. The number of windows is limited only by available memory.  

A complete help system can be accessed through the Help menu.  

The menus and dialogs are typically navigated with the mouse. Keyboard shortcuts are also available for 
virtually all actions. These are activated by the "Alt" key in combination with the underlined letter of the 
individual command. The TAB key moves between items in a dialog. 

3.4 Cautions 

Users of the STEAM program should be aware of several potential pitfalls: 

Changing the units in the Options/Units menu applies only for new tables and plots; it does not change the 
units on the tables already created. 

There are cases where an input state point can result in two separate valid states.  The most common is 
temperature-enthalpy inputs.  Viewing a T-H diagram will help show how there can be two valid state points 
for a given input.  For example, water at 500 K and 1000 kJ/kg can exist at 2.64 MPa and at 69.35 MPa.  
When this situation occurs, STEAM returns the state with the higher density.  See the Specified State Points 
section for information on calculating the upper and lower roots. 

There are certain properties pertaining only to the saturation line, such as dp/dT.  For most cases, displayed 
properties at saturation states are those for the single phase on the saturation boundary.  Thus, derivative 
properties at saturation as well as saturation properties that are given along constant property paths, such as 
Cv, Cp, or Csat, pertain to their state in the single phase.  Those properties label with a '[sat]' indicate a path 
along the saturation line. 
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4. GENERATING PROPERTY TABLES 
(The Calculate Menu) 

The Calculate menu provides several options for generating tables of two distinct types. The Saturation 
Tables and Iso-Property Tables options calculate properties at even spacing of temperature, pressure, 
density, or quality at some fixed value of another property. The remaining options bring up spreadsheet-type 
windows that allow arbitrary values of the independent variables to be entered in a variety of ways. 

4.1 Calculating Saturation Tables 

Selecting the Saturation Tables option in the Calculate menu brings up a dialog box from which the form of 
the table is specified. Vapor-liquid saturation tables display properties for the saturated liquid and saturated 
vapor, denoted by “Liquid” and “Vapor” in the table headings. In addition to varying temperature or pressure, 
a table may be generated where the vapor fraction (quality) is varied at a fixed temperature or pressure. For 
solid-liquid (melting) and solid-vapor (sublimation) calculations, only the properties of the coexisting fluid 
(liquid or vapor) phase are computed and either the pressure or temperature may be chosen as the 
independent variable.   

 

Clicking the OK button brings up a dialog in which the range and increment of the property to be varied and 
the value of the property to be held constant (if applicable) are entered. Default values are provided. The first 
time a table is calculated, the defaults used are based on the current units settings. For subsequent 
calculations, the default values for the range and increment are those from the previous table.  
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The "Leave active" check box at the lower left keeps this dialog as the top window on the screen, allowing 
rapid calculation of a series of tables of the same type. 

Clicking the OK button initiates the calculations. While the calculations are in progress, a small window 
appears indicating the status. To stop the calculations, click the Cancel button. When the calculations are 
complete, a table displaying the results appears. 

 

4.2 Calculating Iso-Property Tables 

Selecting the Iso-Property Tables option in the Calculate menu starts calculation of a table with one property 
held constant and either the temperature, pressure, or density varied over a specified range. The following 
dialog allows the selection of the constant and varying properties. Click on one property from each list.  

 

Clicking the OK button brings up a dialog for specifying the value of the property held constant and the range 
and increment of the varying property; this dialog is similar to that used to calculate saturation tables (see 
previous section). Default values are provided. The first time a table is calculated, the defaults are based on 
the current units settings. For subsequent calculations, the default range and increment are those from the 
previous table. The Leave active check box at the lower left keeps the dialog as the top window on the 
screen, allowing rapid calculation of a series of tables of the same type. Multiple tables generated from this 
procedure can be plotted together by selecting all the generated tables (hold down the shift key) in the New 
Plot menu (Section 5.1).  Alternatively, the Add to current table option will add the calculated values for each 
new isoproperty to the bottom of the current table. 
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Clicking the OK button initiates the calculations. While the calculations are in progress, a small window 
appears indicating the status; you can stop the calculations by clicking the Cancel button. When the 
calculations are complete, a table displaying the results appears. A blank line in the table indicates a change 
of phase. 

 

4.3 Calculating Tables at Specified State Points 

The Specified State Points option calculates properties at arbitrary values of the independent variables. 
Selecting this option from the Calculate menu brings up a blank grid similar to a one-line spreadsheet. 

 

The independent variables can be entered in a number of ways: 

1. Values can simply be typed into the cells of the property table. You can move to any cell by clicking 
the mouse in that cell, or move among cells by pressing the Enter, Tab, or arrow keys. 

2. Values can be pasted into the independent variable cells from another application, such as a 
spreadsheet.  Copy the values to the clipboard using the other application's Copy command.  Then, 
in STEAM, select the desired cell in the table and then use the Paste command. Additional rows will 
be added automatically as needed. 

3. Values can be automatically entered in a systematic manner by right-clicking on the header at the 
top of any column.  This action brings up the Column options window: 
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To fill a table with a range of numbers, enter a combination of values into the cells under the "Specify 
values" section.  The value to be placed in the first desired row must be specified in the "First value" 
field.  Beneath this field are additional input boxes in which the last value in the range, the increment 
(or a multiplier), or last row can be specified.  If "Increment" is selected, the value of successive rows 
in the table is determined by adding the value in the Increment field to the previous value.  Similarly, 
if "Multiply" is selected, successive values are determined by multiplying the previous value by the 
value indicated in the field.  If "Last value" is selected, the variable is varied in uniform increments 
from the specified initial value to the final value.  In the special case where you wish to fill a certain 
number of rows with a constant, enter the starting row, the ending row, and the constant in the "First 
value" field.  The independent values entered must be in the unit system selected with the Units 
command.  You can also specify that the values are saturated liquid or vapor states.  This simply 
adds an "l" or "v" to the number as it places it in the field, as described below. 

4. Values can be read from an ASCII file stored on disk. A specified state point table must be active 
before issuing this command. From the Edit menu, select the Read Data From File command. A 
standard Open file dialog appears in which you may specify the file containing the independent 
property values. Select the file and the following dialog appears. 

 
The window displays the first 20 lines of the selected file in the box at the top of the window so that you can 
see the format of the values in the file. Although only 20 lines are shown, all of the lines are read in when you 
press the OK button.  Lines in the file that begin with a nonnumeric character, such as *, are treated as 
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comments and are ignored.  STEAM will read one or more values from each line in the file and place them in 
corresponding cells in the blank Specified State Points table. 

In the example shown here, temperature and pressure were chosen as the independent properties and are 
read from columns 1 and 2 of the file. It is not necessary to read all of the properties from the file; for 
example, you can read just the temperature by changing the second box to nothing. 

Extra data from the file can be read and placed in a comment column in the Specified State Points table.  
The capability to read additional data from a file is useful in comparing experimental and calculated values of 
a property, for example.  Before this can be done, the "Add a comment column to tables" option must be 
specified in the Preferences dialog (Section 6.4), and a new table containing the comment field must be 
created.  The comment field can then be specified in one of the boxes under the "Insert data into field" label.  
They can then be plotted along with calculated values. 

Whether the independent properties are read from a file or entered manually, as soon as any two valid input 
properties have been entered, the remaining properties will be calculated and displayed in the appropriate 
columns. The inputs can vary from row to row (for example, temperature and density for one row and 
temperature and enthalpy for the next), but not all combinations are supported. Note that you can then 
change the inputs or select new inputs (which causes the calculated values in that row to be erased) and 
repeat the calculation process. 

Saturation or melting states can be calculated by adding the letters "l", "v", or "m" before or after the value of 
temperature, pressure, density, enthalpy, or entropy.  Note that "m" returns liquid properties at the solid-liquid 
boundary.  STEAM does NOT calculate solid properties.  In the case where "l" or "v" is entered, and there is 
only one valid liquid or vapor state point, that point is returned regardless of whether or not it is in the liquid 
or vapor state.  If a liquid density is entered with a "v", the liquid state is calculated internally; however, the 
vapor state is returned.  The same is true for a vapor state entered with "l".  The properties at the critical 
point can be calculated easily by entering "cr", and the properties at the triple point can be calculated by 
entering "tr" (liquid properties can be obtained with "trl" and vapor properties with "trv"). 

For state points that are double-valued, the character "<" or ">" can be added to the number (before or after) 
to find the lower or upper root, respectively.  These same characters can also be used to find metastable 
fluid states for temperature and pressure inputs.  For example, the saturation pressure at 500 K is 2.639 
MPa.  Inputs of 500 K and 2.63 MPa will return a vapor state, but inputs of "500" for temperature and "2.63>" 
for pressure will return a metastable liquid state. 

Saturation properties at specified points may also be calculated using the Saturation Points options as 
described below. 

4.4 Calculating Saturation Properties at Specified Points 

Saturation properties may be calculated at specified points in a manner similar to the Specified State Point 
options described in the previous section. The Saturation Points option calculates properties at arbitrary 
values of an independent variable. Selecting this option from the Calculate menu brings up a blank grid 
similar to a one-line spreadsheet. 
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The independent variable can be entered in the same way as for the Specified State Points tables; see 
Section 5.3. The primary differences are that the Saturation Points tables will have a liquid and a vapor 
column for each property, and only one independent variable is needed to specify the state.  Allowed 
independent variables are the temperature, pressure, and vapor or liquid densities. 

4.5 Reformatting Existing Data Tables 

The property values are displayed in the calculated tables in a default format, which should be acceptable for 
most uses. The format of a column can be changed, or its position in the table shifted, by right-clicking on the 
column heading. This brings up the following dialog. 

 

In addition to the default format, three other formats are accessible by clicking on the Style drop-down arrow. 
The "Fixed decimal" style displays values with a fixed number of digits after the decimal place. The "Fixed 
digits" style displays values with a fixed number of significant digits. The "Scientific notation" style displays 
values in scientific notation with a fixed number of digits in the ordinate. You can select the desired number 
of digits by typing the value in the edit box, or using the small up or down arrows to increase or decrease the 
displayed value. An example of the selected format is shown above the style drop-down box. 

The user is cautioned that, by the very nature of a calculational database, property data are often displayed 
with more digits than can be justified based on the accuracy of the property models or the uncertainties in the 
experimental data to which the models were fitted. A large number of digits may be useful for the smooth 
plotting of results, the evaluation of numerical derivatives, or checking results with the original source.  

The position of a column in the table can be changed by editing the value in the edit box in the middle of the 
dialog. The number of digits can be changed for all columns and all tables in the Preferences dialog under 
the Options menu (see Section 6.4). 

The width of the data columns can be changed by placing the mouse over the line separating the header of 
two columns. When the cursor changes to a double-headed arrow, click and drag the line to a new position. 
The column widths are also enlarged in some operations when the width of the numbers in the column 
exceeds the column width. 

4.6 Warnings and Errors 

It is not always possible to complete the requested property calculations. In such instances, the program 
returns a notation such as "not applicable" in a table cell, a warning message, or an error message.  
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Certain properties are not defined at states that are otherwise valid. For example, the viscosity and speed of 
sound are not defined for a two-phase state. The surface tension is not defined for single-phase states. In 
such cases the term "not defined" is displayed in the corresponding table cell(s), and the remaining 
properties are displayed normally. The quality can be defined in a variety of ways for subcooled liquid and 
superheated vapor states, and it is not defined for supercritical states. In these cases, the state (subcooled, 
superheated, or supercritical) is displayed in the table cell(s) for quality. 

Warnings indicate a situation in which the calculated values may be suspect. The user is informed that one 
or more requested states has resulted in a warning by an Alert box, which is displayed after all calculations 
have been completed. The entire row in the table resulting in a warning is displayed in an italic font (even 
though the warning may arise from the calculation of a single property). You can view the warning message 
by clicking the affected row number(s). 

 

Warnings are most commonly encountered when transport property values are requested at a temperature 
and/or pressure outside of the range of the model used for the calculations. (The transport property models 
have a more limited range than the thermodynamic property model; in these cases, the thermodynamic 
properties are calculated normally, but the transport properties generate a warning.) Warnings are also 
issued when the temperature and/or pressure are above the stated limits of the equation of state. 

An error indicates a situation in which calculations are not possible. This may be because of the failure of an 
iteration loop within the property routines to converge on a solution, but more commonly, is because states 
were requested for which calculations are impossible. For example, saturation calculations are not possible 
above water’s critical temperature. In addition, while an equation of state can usually be extrapolated to 
slightly higher temperatures or pressures than the stated limits with good results, extrapolation to lower 
temperatures or higher densities can give nonsensical results and is not allowed.  

When an error is generated by the property routines, an Alert box is immediately displayed giving the error 
message and the option to continue or cancel further calculations in the table. If the Yes button is clicked, 
calculations continue (although further errors are likely). The "Yes to All" button suppresses further error 
messages of the same type. If the No button is clicked, any rows calculated before the error was 
encountered are displayed, but no further calculations are attempted. 
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5. CREATING AND MODIFYING PLOTS 
(The Plot Menu) 

The STEAM program provides plotting capability for any data appearing in a table. In addition, simple plots of 
the thermodynamic surface can be easily generated, including temperature-entropy and pressure-enthalpy 
diagrams. While these plotting capabilities help in the visualization of data trends and are adequate for many 
other purposes, the program is not intended to compete with programs devoted to plotting and data analysis. 
If you need to produce publication-quality plots or to carry out statistical analyses or other data 
manipulations, we recommend that you transfer the property data from STEAM to such a program. Section 8 
of this manual describes the process for transferring data to other programs. 

5.1 Plotting Data from Tables 

Once one or more property tables have been calculated, x-y plots can be generated by the New Plot 
command. The dialog shown below is divided into three blocks, which control the x-axis, the y-axis, and the 
source and appearance of the plotted data. 

 

By default, it is assumed that data from the topmost table window are to be plotted. Other tables can be 
selected using the list at the upper right of the dialog. It is also assumed that all rows in the selected table are 
to be plotted. If this is not desired the starting and ending row numbers can be entered in the edit boxes 
below the table list.  Data from multiple tables can be plotted simultaneously by selecting multiple items in 
the "Plot data from" list and pressing "OK".  You must be careful that the selected items all contain the same 
columns. Plotting data from isoproperty tables and saturation tables together must be done in two steps 
(once with New Plot, then with Overlay Plot, see next section). 

The variables to be plotted on the x- and y-axes are selected by clicking the properties listed in the scroll 
boxes at the left and middle of the dialog.  

Minimum and maximum values for the plot frame are generated as the x- and y-variables are selected. The 
"Interval" value represents the spacing of axis tick marks. These values can be changed by typing new 
values; they can also be changed later using the Modify Plot command, which is described below. The 
format of the axis labels is controlled by two small drop-down boxes. The first provides access to a fixed 
decimal format, "F", or exponential notation, "E". The second "Format" drop-down box controls the total 
number of digits (before and after the decimal point) with either format. Either a linear or logarithmic axis 
scaling can be specified by the radio buttons at the bottom of the dialog. Finally, a check box turns grid lines 
on or off. 
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The appearance of the plotted points is controlled by the options in the lower right portion of the dialog. 
Points can be connected by a variety of line widths, or no line at all, by selecting the desired option in the 
drop-down list labeled "Line." The "Symbol" drop-down list provides access to a variety of plotting symbols, 
including no symbol. (The choice of "none" for both the line type and symbol is allowed, but this results in a 
rather uninteresting plot.) The color of both the line and symbol is also controlled by a drop-down list. The 
default values for these attributes can be saved by clicking the Save As Default button. 

5.2 Overlaying Data onto Existing Plots 

You can plot additional data onto existing plots by using the Overlay Plot command. The command acts on 
the topmost plot window; if a different plot is desired, select it before executing the Overlay Plot command. 
This command brings up a dialog virtually identical to that for New Plot, and works in the same way. Overlaid 
plots use the existing scales for the ordinate and abscissa.  However, if the overlaid plot has values that 
cause part or all of the plot to be off scale, a dialog is presented that asks if you want to rescale the plot. It is 
the user’s responsibility to ensure that plots are not overlaid in meaningless combinations. In particular, the 
quantities in the individual data sets plotted should have the same units. 

5.3 Predefined Diagrams of Thermodynamic Surfaces 

A number of common diagrams are predefined in the program and can be automatically generated. Once 
plotted, these predefined plots can be modified, or additional data can be overlaid on them, in the same 
fashion as for any other plot. The types of diagrams that can be plotted include: 

Temperature vs. Entropy 
Temperature vs. Enthalpy 
Temperature vs. Density 
Pressure vs. Enthalpy 
Pressure vs. Density 
Pressure vs. Volume 
Pressure vs. Temperature 
Compressibility Factor vs. Pressure 
Enthalpy vs. Entropy 
Isochoric Heat Capacity vs. Temperature 
Isobaric Heat Capacity vs. Temperature 
Speed of Sound vs. Temperature 
Exergy vs. Enthalpy 
Isothermal Compressibility vs. Temperature 
Viscosity vs. Temperature 
Thermal Conductivity vs. Temperature 

Selecting any of these options brings up a dialog in which the properties to be plotted can be specified as 
shown below.   
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Each diagram type will allow different combinations. In the example shown, a pressure vs. enthalpy diagram 
can display lines of constant temperature, density, entropy, and/or quality. To plot a property, place a check 
in the box to the left of the label.  You can then specify a range of values to be plotted or up to 12 individual 
values (by pressing the "More" button), or both.  

The minimum and maximum values of the x and y axis can be modified. These values can also be changed 
later with the Modify Plot command; however, some data may not be calculated beyond the ranges indicated 
in these boxes, and a new diagram will have to be generated with larger bounds. 

For cases where multipliers are preferred rather than increments in the "From...To...Step" inputs, the 
character "*" can be added in front of the step input.  Thus, inputs of "From:  0.001, To:  1000, Step:  *10" 
would produce isolines of 0.001, 0.01, 0.1, 1, 10, 100, and 1000.  The More/Less button can be selected to 
include/exclude additional boxes where property values can be individually added. 

Labels identifying the isoproperties are automatically generated if the "Include labels" option is selected.  You 
can change or delete these text items or add additional text using the Add Label command.  If too many 
labels are being placed on a plot, the "Unlabeled lines" option can be used to specify that labels should occur 
on every other line, every third line, and so on.  The appearance of the plot can be modified with the Modify 
Plot command and with the controls in the Plot window. 

The amount of data calculated, resulting in fine or coarse plots, can be selected in the "Point spacing" option.  
Several additional options are available to control whether the saturation lines are drawn, the melting line is 
drawn, and the saturated liquid and vapor states are connected by lines.  The "Swap density for specific 
volume" option will change the density inputs to volume inputs.  The "Add s and v lines at saturated 
temperature" option will draw a vapor phase isochore and a vapor phase isentrope for each isotherm that is 
plotted, using the value of volume and entropy at the saturated vapor state point. 

Other properties can be plotted as well using these same techniques.  Under the "Axis" scaling label in the 
plot dialog, the x and y properties can be changed by selecting the down arrows and clicking on the desired 
property.  Most of the properties available in the Properties dialog can be plotted on the y axis.  Properties 
allowed on the x axis include temperature, pressure, density, volume, energy, enthalpy, entropy, 
compressibility factor, exergy, and –1/T.  In order to avoid problems where one of the four columns at the top 
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of the plot dialog matches one the properties on the x or y axis, you should carefully select as a starting point 
one of the diagrams in the Plot pull down menu that contains your x or y property.  For example, to generate 
a plot showing the Prandtl number vs. temperature, you could start with a T-s diagram so that the upper four 
columns show pressure, density, enthalpy, and quality.  If a T-h plot was selected, then the third column 
would contain entropy instead of enthalpy.  Once this is done, the y axis property should be changed to the 
Prandtl number.  Once the initial plot is setup, you can then go to the Plot/Other Diagrams option to modify 
your previous settings. 

5.4 Modifying Plots 

5.4.1 The Modify Plot command 

Many of the attributes of a plot can be changed through the Modify Plot command. This command can be 
accessed by the pull-down menu item or by double-clicking anywhere within an existing plot. In the former 
case, the plot in the topmost window is affected. If the topmost window is not a plot, the most recent plot is 
acted on. 

The dialog for this command is similar to that used to specify a new plot, except that the variables plotted 
cannot be changed (although the x- and y-axis labels can be edited). As with the New Plot command, linear 
or logarithmic scaling can be selected, and the plot limits and axis label formats can be changed. Options to 
modify the size of the axis labels are provided below the "X-Axis" and "Y-Axis" portions of the dialog. 

 

A list box in the upper right lists the individual data sets plotted. Selecting an item allows editing of the line 
and symbol attributes for that data set. The Remove button permanently deletes the selected data set. (Note 
that for the predefined plots, there is an entry for each of the lines composing these diagrams.) Select the 
data set for which the line type, symbol, and/or color specifications are to be applied. These changes can be 
made to one data set at a time or to a multiple selection (by shift-clicking). After changes have been made, 
either the Apply button or the OK button can be selected.  By pressing the Apply button, other changes can 
be made as well. 

5.4.2 Adding and deleting labels 

The Add Label command places text in a plot window. A plot must be in the foremost window for this 
command to be active. Invoking this command brings up a dialog in which you can type the desired text. 
Other text characteristics including the font, size, and color can also be edited. The "Opaque background" 
option is invoked by a check box; when this option is turned on, any lines "underneath" a text label are 
blocked out. 
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You can modify an existing label (including those generated through the predefined plots) by double-clicking 
within the boundaries of the text. A label can be permanently deleted with the Delete button. The Delete All 
button deletes all the labels on a plot. 

Labels can be moved by clicking within the text boundaries and dragging the text to its new location. 

The degree character can be entered into the text of the label by pressing Alt-248 (or Alt-0176) on the 
numeric keypad.  Alt-253 will add a superscript "2" to the text.  In addition, Alt-0178 will add a superscript "2" 
and Alt-0179 will add a superscript "3".  Other special characters of interest using the Alt key include 225: ß, 
230 (or 0181): µ, 241 (or 0177): ±, and 246: ÷.  

5.4.3 Resizing and moving plots 

The size of the plot frame can be changed. Place the cursor over the lower right corner of the plot window; 
the cursor changes to a double-ended arrow to indicate that you are in the resize mode. Click and hold the 
mouse button while dragging the corner of the plot to enlarge or reduce the plot size. 

5.4.4 Reading coordinates off a plot 

You can display the (x, y) coordinates of any location within the plot frame. Press the Shift key to display 
cross hairs within the plot frame and numerical coordinates (in units corresponding to the plot axes) appear 
in the title bar of the plot window. Use the mouse to move the cross hairs to any desired point in the plot.  

5.4.5 Zooming 

The area displayed in a plot can be changed. Click and drag the left mouse button to create a box.  When 
the mouse button is released, the area within the box will become the new plotted area. The plot area can 
also be zoomed in or out by a factor of two with the Zoom In and Zoom Out options in the Plot menu. The 
Zoom Full Frame option returns the plot to its original bounds set by New Plot or Modify Plot. 

5.4.6 Add a point to a table 

When the right mouse button is clicked within the plotting area, the spot will be marked with a circle, and the 
values of the properties at the selected state point will appear on the most recently used table (created from 
Calculate/Specified State Points).  If no table is active, the right mouse button marks the spot with a circle 
only.  Points added to the plot in this fashion can then be connected with lines or deleted by entering the 
Modify Plot option. 
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6. CHANGING OPTIONS AND PREFERENCES 
(The Options Menu) 

Under the Options menu, you can choose the units of measure for the calculations, the properties to be 
displayed, and other options. All of these options can be saved (together with the currently defined fluid or 
mixture) for use in a future session. Any changes in these options apply to all subsequent tables but do not 
affect any existing tables (with one exception, as explained below). 

6.1 Units 

The Units command brings up a dialog in which the units of the various properties can be specified. The 
current settings are displayed down the left side of the dialog window. Some properties use combinations of 
the displayed settings and cannot be specified independently. For example, if kilograms and kilojoules are 
specified for mass and energy, respectively, enthalpy is displayed in units of kJ/kg. 

 

Multiple buttons are available for selecting default sets of units; for example, standard SI or English units.  
Other sets include standard SI units with Celsius for temperature, a mixed set of SI and English units, and an 
option to use unitless dimensions for some variables, including temperature divided by the critical 
temperature, pressure divided by the critical pressure, and so on.  Units can also be set individually—click on 
the arrow to the right of the current unit setting. A drop-down list of available choices appears. Click the 
desired unit.  

Specific properties (i.e., those expressed in terms of a unit quantity) are reported on either a mass or molar 
basis (e.g., kJ/kg or J/mol). Select the desired basis by the radio buttons under the heading "Properties." The 
molar and mass bases govern the selection in the Mass list box. For example, selecting "kg; kmol" specifies 
kilograms if the mass basis is selected and kilomole (often called a kilogram mole) for the molar basis; 
selecting the English units "lb; lb mol" specifies pounds and pound moles.  

Pressures can be expressed as gage pressures by selecting the "Use Gage Pressure" option.  The 
atmospheric pressure or elevation at the location of interest is required to use this option. 
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6.2 Properties Calculated 

The properties to be displayed in calculated tables are controlled by the Properties dialog. The properties are 
organized into categories that are accessed by the tabs at the top of the dialog. Click on the desired category 
tab and select or deselect any property by clicking the check box next to its name. All of the properties for the 
displayed category may be selected or deselected by the "Select All" or "Clear All" buttons at the lower right. 
Results from the Thermodynamic tab are shown below: 

 

 

In the lower part of the dialog, a pair of radio buttons controls whether properties for the liquid and vapor 
phases are to be displayed in addition to bulk properties. Liquid-phase properties are denoted by "Liquid" or 
"Liquid phase" in the table heading; "Vapor" or "Vapor phase" denotes the vapor-phase properties. The bulk 
properties have neither designation. For single-phase states, the bulk properties are the same as either the 
liquid- or vapor-phase properties.  For two-phase states, the properties of the overall or bulk state are a 
combination of the saturated liquid and saturated vapor properties. Note that some properties, including 
speed of sound and viscosity, are not defined for two-phase states. (For saturation tables, this choice affects 
only tables with quality as the independent variable. For other types of saturation tables, the saturated liquid 
and saturated vapor properties are always displayed.) 

Most thermodynamic and transport properties can be calculated.  The properties that can be displayed are 
divided into five categories:  thermodynamic properties, transport properties (plus surface tension, refractive 
index, and ionization constant), derivatives of the thermodynamic properties including isothermal 
compressibility and volume expansivity, special properties, and properties related to the static dielectric 
constant. Examples of the properties available for the various tabs (other than the Thermodynamic tab) are 
shown below: 
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Thermodynamic properties include temperature (T), pressure (p), density (D), volume (V), internal energy (e), 
enthalpy (h), entropy (s), isochoric (Cv), isobaric (Cp), and saturation (Csat) heat capacities, ideal gas 
isobaric heat capacity (Cp0), ratio of Cp to Cv, speed of sound (w), compressibility factor (Z=p/DRT), Joule-
Thomson coefficient (JT=dT/dp at constant h), quality (q=ratio of vapor moles to total moles), 2nd virial 
coefficient (B), 3rd virial coefficient (C), Helmholtz (a) and Gibbs (g) energies, and the heat of vaporization 
(hvap).  Most of these properties are given on a molar or mass basis, e.g., V=volume/number of moles, or 
volume/mass.   

The transport (plus miscellaneous) properties include the thermal conductivity (ThC), viscosity (Vis), 
kinematic viscosity (Vis/D), thermal diffusivity (ThC/D/Cp), and Prandtl number (Vis*Cp/ThC).  The surface 
tension, refractive index (the user must specify the wavelength) and ionization constant Kw are included 
under this tab. 

Derivative thermodynamic properties include the isothermal compressibility [kappa=1/kt/p= –(dV/dp)/V at 
constant T], volumetric expansivity (also known as the thermal expansion coefficient) [beta=(dV/dT)/V at 
constant p], isentropic expansion coefficient [k=w2*D/p=–V/p(dp/dV) at constant s], isothermal expansion 
coefficient [kt=D/p(dp/dD) at constant T], adiabatic compressibility [betas=1/k/p=–(dV/dp)/V at constant s], 
adiabatic bulk modulus [Bs=k*p=–V(dp/dV) at constant s], isothermal bulk modulus [Kt=kt*p=–V(dp/dV) at 
constant T], and isothermal throttling coefficient (–JT*Cp = dh/dp at constant T).  Additionally, properties 
contained under the derivative tab include most of the common derivatives of density, pressure, temperature, 
and enthalpy with each other.  The property dp/dT [sat] is the derivative of the vapor pressure with respect to 
temperature.  The property dh/dZ [sat] is the Waring function (as given in Ind. Eng. Chem., 46:762, 1954) 
and dB/dT is the derivative of the second virial coefficient with respect to temperature (B is a function only of 
T). 

Special properties include the acoustic virial coefficients, the negative reciprocal temperature (–1/T), exergy 
on a flow basis (H–T0S), exergy for a closed system (H–P0V–T0S), specific heat input [V(dh/dV) at constant 
p], and the critical flow factor (the normalized sonic mass flux for inviscid, one-dimensional, steady, isentropic 
flow). 

On the Dielectric tab, properties include the static dielectric constant and its derivatives with respect to 
various properties.  Also under this tab are the Debye-Hückel slopes used in the physical chemistry of 
electrolytes to describe the behavior of certain solution properties in the limit of low electrolyte concentration; 
see Section A.3 and the references cited there for further information.  
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6.3 Property Order 

The property order dialog, shown below, establishes the order in which the properties are displayed in a 
table. 

 

Select the property that you wish to move, and use the "Move Up", "Move Down", "Move to Top," or "Move to 
Bottom" buttons to change the position of that property in any subsequent tables.  The property order can 
also be changed by selecting a property with the up and down arrow keys or the mouse, and then moving 
the property using the up and down arrow keys while holding down the shift key. 

6.4 Preferences 

The Preferences item in the Options menu brings up a dialog in which you can specify the behavior of the 
program in a number of aspects. Clicking on the check box next to the item activates or deactivates that 
option. 

If the "Prompt to save session when closing" option is selected, you will be prompted when the program is 
terminated to save the session to a file before closing.  This file can then be retrieved by selecting the Open 
Session command (Section 8.2) when the program is run again. 

The "Prompt before deleting row" option prompts you before a row is deleted in a table (by either pressing 
Shift-del or selecting the Delete Row option while editing a table). Note that a row cannot be recovered after 
it has been deleted.   

The "Ignore all error messages" option will cause all error messages that occur during property calculations 
to be ignored.  While this option may relieve you of having to clear such error messages, it may cause 
confusion when properties are not returned after entering inputs out of range or when the program does not 
converge. 

The "Copy table headers to clipboard with table data" option can be used to select whether or not the 
headers at the top of each table are included when copying data to the clipboard (Section 9.1). (Table 
headers are automatically suppressed when you paste data into a Selected State Points table.) 

When the "Show saturation boundaries in tables" option is selected, a blank line will appear between the 
single and two-phase state points and the boundary between the liquid and vapor phases in subsequent 
tables. 

In certain applications, such as using Asian settings with Microsoft Windows, the degree sign, the superscript 
2, and the superscript 3 may not be properly displayed, causing unit conversions to not work and displaying 
units with odd symbols.  In such cases, the nonstandard characters should be turned off, resulting in the loss 
of the degree signs. The text "^2" and "^3" will be used in place of the superscript 2 and 3. 
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The "Flip usage of commas and periods in numbers" option allows STEAM to conform to either the European 
or American convention for the decimal point. STEAM will, however, usually recognize a user's system 
settings, and this option will not be required. 

The "Add Notes button to graphs" option will add a small command button in the upper left corner of each 
plot that allows the user to add notes to a particular graph.  These notes will be printed out under the plot 
when File/Print is selected.  If this option is deselected, the notes that correspond to each plot will not be lost, 
but will not be accessible. 

The option to add a comment column to tables will add one or more extra columns (up to 10) in each table.  
The extra column(s) can be used to enter comments or user data.  The values in this field will be ignored in 
calculations, but numerical values can be plotted in the same manner as calculated properties.  Adding text 
in each field can aid you in labeling each state point, and the size of the comment field can be enlarged by 
clicking and dragging the mouse. The comment columns are put at the end of the table by default, but this 
can be changed under Property Order as described in Section 6.3. 

In addition to these options, the number of digits in the tables and the font size used for the tables can be 
selected on a global basis, rather than by individually selecting the number of digits as described in 
Reformatting Existing Data Tables (Section 5.5). Changes in the number of digits displayed will be applied to 
currently displayed tables if the "Apply to existing tables" option is selected. The "Fixed decimal" style 
displays values with a fixed number of digits after the decimal place. The "Fixed digits" style displays values 
with a fixed number of significant digits. The "Scientific notation" style displays values in that format with a 
fixed number of digits in the ordinate. An edit box below the style can be used to select the desired number 
of digits, or the small up or down arrows can be used to increase or decrease the displayed value. 

The preferences are saved when the Save Current Options command is issued (see Section 6.3).  They are 
restored to a previously saved option with the Retrieve Options command (see Section 6.6). 
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6.5 Saving Current Options and Preferences 

The current settings can be saved at any time. The settings saved include the currently defined units of 
measure, the reference state for enthalpy and entropy, the properties to be displayed, and the options 
specified in the Preferences dialog. Selecting the Save Current Options command brings up a file save 
dialog in which you can specify the filename to contain the current settings. Settings files are identified with 
the ".prf" file name extension. You can save multiple settings files corresponding to different projects. 

The program reads the settings file "defaults.prf" at startup. If you want to have the current options used as 
the default settings, save them in the "defaults.prf" file. An Alert box informs you that the file already exists 
and asks if you want to replace the existing file; click Yes to save the new defaults. To start STEAM with a 
different preferences file, include the name of that file on the command line used to start STEAM. 

If the "defaults.prf" file is deleted or missing, the program will revert to internal defaults (which will probably 
not correspond to your preferences). If you inadvertently delete the "defaults.prf" file you can rename another 
settings file to "defaults.prf" and place it in the same directory as the STEAM executable. 

6.6 Retrieving Previously Defined Options 

Any previously stored settings can be loaded by executing the Retrieve Options command. This brings up a 
File Open dialog. The settings files are identified by a ".prf" filename extension. Select the name of the 
desired settings file and click OK to load those previously defined settings including the units of measure, the 
reference state for enthalpy and entropy, the properties to be displayed, and the options specified in the 
Preferences dialog. 
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7. SAVING AND PRINTING 
(The File Menu) 

7.1 Saving and Closing Sessions 

A session in the STEAM program consists of all table and plot window(s) on the screen together with the 
settings defining the unit system and selected properties used to generate those windows. You can save a 
session at any time. This means that the complete current state of the program is saved to disk. The Save 
command brings up a File dialog. Select the desired directory and enter a filename; the ".stm" file-type 
extension identifies a file as a STEAM session file to the program. 

The Close command closes all table and plot windows currently on the screen, but the program itself 
remains running. If you have not already saved the session, a dialog asks if you want to save the current 
session before closing (unless you have disabled this reminder under the Preferences dialog). 

7.2 Retrieving a Previously Saved Session 

A previously saved session can be retrieved by the Open command. This command, combined with the Save 
command, is a very powerful combination that allows you to stop work on a STEAM analysis and return to it 
later or work simultaneously on several different analyses at one time. 

The Open command brings up a File dialog where you specify the file storing the desired session. Upon 
pressing the OK button, the specified session is restored with all of its constituent tables and plot windows on 
the screen. The settings defining the unit system and selected properties used to generate those windows 
are also restored. Opening a saved session will delete any current windows; in this case an alert box will ask 
if you wish to save the current work first. 

7.3 Saving Tables 

The Save Tables command displays a dialog that allows you to select one or more of the current tables to be 
saved to disk in an ASCII format. The available tables are shown in the list at the left, with the most current 
one shown on the right. Click on the name of the table you want to save and then click on the ">" button to 
add that table to the list of tables to be saved on the right. The ">>" button moves all of the available tables to 
the right list. You can remove a table from the "to be saved" list by highlighting its name and pressing the "<" 
button. Similarly, all of the tables can be removed by pressing the "<<" button.  

 

The check boxes at the lower left provide the option to include the column heading (consisting of the property 
and units on separate lines) and/or the row numbers together with the data. A delimiter selected by the radio 
buttons at the lower right is placed between each value in a row. Most spreadsheet programs use the tab 
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character to place items in separate cells. A carriage return is placed at the end of the row. When saving 
tables, the "Full width" option prints each line of the table on a single line of the file; this can result in very 
long lines.  The "Page width" option formats the tables so that all the properties fit within 80 columns in the 
file.  The lines are broken up and printed in different sections, similar to that done during printing. Multiple 
tables, if specified, are saved to a single file. The tables in the selected list are saved or printed in the order 
in which they appear in the list. 

7.4 Printing 

The Print Setup command brings up the standard Print Setup dialog that provides access to print options, 
such as landscape or portrait format and printer selection. These options are applied to subsequent output 
from the Print command. This command need be used only when the default printer or printer options are to 
be viewed or changed. 

The Print command allows any of the tables or plots to be printed. The available windows are shown in the 
list at the left, with the most current one shown on the right. Click the name of the table or plot you want to 
print and then click the ">" button to add that window to the list on the right. The ">>" button moves all of the 
available windows to the right list. You can remove an item from the "print" list by highlighting its name and 
pressing the "<" button. Similarly all of the tables and plots can be removed by pressing the "<<" button. 
Clicking OK initiates the print process. 

 

The check boxes at the lower left allow you to include the column headings (containing the property names 
and units) and/or the row numbers on the printed output of tables. The "Include header" check box will also 
print out the window header containing the date, time, etc. Multiple tables or plots are printed in the order 
they appear in the "to be printed" list. 

The Print Dialog command allows for a few additional options while printing, most important is the "Print to 
file" option.  This option sends the output to a file that can then be used in such applications as making 
PDFs.  Unlike the Print Setup command, the Print Dialog command first displays the menu for selecting 
tables or plots to print, then activates the dialog menu before printing. 

7.5 Exiting STEAM 

The Exit command provides a graceful way to exit (quit) from the program. You are prompted to apply Save 
Session if it has not already been saved (unless this prompt has been turned off under the Preferences 
command, see Section 6.4). Memory allocated by the program is released. 
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8. IMPORTING AND EXPORTING DATA 
(The Edit Menu) 

8.1 Copying Data or a Plot to the Clipboard 

The Copy Table Data and Copy Plot commands can be used to copy a plot or selected data from an existing 
window to the Clipboard. (The Clipboard is an area of memory used to exchange data within and between 
applications.) It can then be pasted into another application, such as a word processor or spreadsheet.  

To copy a plot, bring the desired window to the front by clicking on it or by selecting its name under the 
Windows menu. Then select the Copy Plot command. The plot is placed on the Clipboard as a bitmap 
graphic, which can be pasted into most applications. 

To copy data, it is first necessary to select the cells to be copied. To select a block of data, click the cell at 
one corner of the block, then press Shift and click at the diagonally opposite corner of the block. You can 
also select a block by clicking and dragging the mouse over it. You can select the entire table by choosing 
the Select All command under the Edit menu.  The Copy All Table Data command copies all of the 
information in a table to the clipboard. 

Once a block of data is selected, executing the Copy Table Data command copies it to the Clipboard. The 
table headings may also be copied along with the data, depending on the setting in the Preferences dialog 
(see Section 6.4).  

The Save Tables command provides another way to exchange data with other applications; see Section 7.3. 

The Save Plot Data Points command will save to a file all of the data points used in generating a plot.  The 
first column is the x-axis value, the second column is the y-axis value, and the third column indicates whether 
or not to connect the point with the previous one.  This command is not intended for general use. 

8.2 Pasting Data from the Clipboard 

The Paste command places the contents of the Clipboard into the currently active input cell or edit box. This 
capability can be used to copy individual items, but is most useful in filling in the independent variables in a 
"Specified State Points" or "Saturated Points" table. To paste data into such a table, first click the top-left cell 
of the block into which you wish to place the Clipboard data, then choose Paste from the Edit menu. Entries 
in the same row must be separated by the tab character, and a carriage return character must be used to 
delineate rows. (This is the format used by the STEAM Copy command, and it is the norm for data copied to 
the Clipboard by most spreadsheet applications.) 

8.3 Inserting and Deleting a Row of Data 

The Insert Row command inserts a blank row into the current table where the cursor is located.   The Delete 
Row command allows a specified row to be permanently removed from the table.  In both cases, the rows 
are not renumbered. These commands are accessible only if a window displaying a table is active.  Clicking 
on a table cell and pressing the delete key will erase the data from that row, but the row itself will remain. 
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9. MANIPULATING DATA TABLES AND PLOTS 
(The Window Menu) 

Each table or plot appears in a separate window and can be accessed, rearranged, or retitled with 
commands in the Window menu. The Window menu contains three permanent options: Tile, Cascade, and 
Retitle. An additional menu item is provided for each table or plot window on the screen. The number of 
windows is limited only by available memory.  

9.1 Arranging Windows on the Screen 

The Tile command resizes and repositions the existing windows so that all are displayed. 

The Cascade command overlaps all of the existing windows so that their title bars are visible, making it easy 
to select any of the windows. 

In addition to the Tile and Cascade commands, windows can be rearranged in the usual fashion by clicking 
and dragging on the title bar. Windows can be resized by clicking and dragging the lower right corner or by 
using the buttons in the top right corner.  

9.2 Renaming Windows 

Each table and plot is provided with a default title when it is generated. These titles are used to identify the 
window(s) acted upon in the Save Tables, Print, New Plot, and Overlay Plot commands. The title of any 
window can be changed by first clicking anywhere in the window or clicking its title under the Window menu 
(to make it the active window) and then clicking on the Rename Window command. A dialog box appears 
listing the current title with an edit box where a new title can be entered. 

9.3 Going to a Window 

Any window on the screen can be brought to the front and made the active window by clicking anywhere in 
the window. Alternately, you can click its title under the Window menu. 
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10. THE HELP SYSTEM 
(The Help Menu) 

Help is available under the Help menu. The help system used in STEAM is a standard implementation and 
works in the manner of most other Windows applications. 

The Help Index command brings up a listing of the main topics in the help system. Click on the item for which 
you would like additional information. You can also access Help from most individual dialog boxes. Pressing 
the F1 key places you in the help system at the point containing instructions for the use of that dialog.  

 

The About STEAM command brings up the banner that is displayed on the opening screen. 
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Appendix A 
 

DOCUMENTATION OF PROPERTY CALCULATIONS 
 

In this Appendix, we document the sources of the property formulations implemented in this database, along 
with their ranges of validity. In some cases, information about the uncertainty of calculations is given.  More 
details can be found in published articles and in documents prepared by the International Association for the 
Properties of Water and Steam (IAPWS, see www.iapws.org).  References are denoted by numbers in 
[brackets] and collected in Section A.8. 

A.1 Thermodynamic Properties 

In the NIST/ASME Steam Properties database, the equilibrium thermodynamic properties for water are 
calculated from the IAPWS Formulation 1995 for the Thermodynamic Properties of Ordinary Water 
Substance for General and Scientific Use, commonly known as IAPWS-95, issued by the International 
Association for the Properties of Water and Steam (IAPWS) [1,2]. 

This formulation should NOT be confused with the separate “Industrial Formulation” known as IAPWS-IF97, 
issued by IAPWS primarily for the steam power industry [3,4]. IAPWS-IF97 is designed for speed in industrial 
calculations; it is slightly less accurate and less internally consistent than the IAPWS-95 formulation in this 
database.  Software and steam tables based on IAPWS-IF97 may be obtained from the American Society of 
Mechanical Engineers (ASME). 

The IAPWS-95 formulation consists of a fundamental equation for the Helmholtz energy per unit mass (kg), 
made dimensionless by RmT, (where Rm is a mass-based gas constant and T is the temperature assumed to 
be on the International Temperature Scale of 1990 [5]), as a function of temperature and density. All other 
thermodynamic properties can then be obtained by differentiation of this surface. Conditions of vapor-liquid 
equilibrium can be established by finding a pressure where, at the given temperature, the vapor and liquid 
densities produce not only that pressure, but also identical Gibbs energies. 

Some properties may be reported on either a mass or molar basis. The IAPWS-95 formulation is in terms of 
mass; conversion to moles is performed using a molar mass of 18.015268 g/mol. This molar mass 
corresponds to that of Vienna Standard Mean Ocean Water (VSMOW), which is an internationally 
recognized standard for the isotopic composition of water [6-8]. 

Some properties (such as isobaric heat capacity, isothermal compressibility, speed of sound, and Joule-
Thomson coefficient) are not defined in the two-phase region. Therefore, calculations at a two-phase 
condition produce a result of “Undefined” for these properties. 

For a two-phase condition, quality is defined as the amount of water in the vapor phase divided by the total 
amount of water. For the saturated liquid and saturated vapor, the quality is 0.0 and 1.0, respectively. One-
phase fluids that are subcooled or superheated are so designated. If the pressure is above the critical 
pressure (22.064 MPa), there is no rigorous definition of these terms; the database designates the fluid as 
“subcooled” if the temperature is below the critical temperature and the quality is “undefined” if it is above. 

Quantities related to energy and entropy are computed relative to an arbitrary reference state, since only 
differences between thermodynamic states are relevant.  For water and steam, the reference state is fixed by 
the longstanding convention that the internal energy and entropy are both zero for the saturated liquid at the 
vapor-liquid-solid triple point (273.16 K). 

For the enthalpy and other quantities containing dimensions of energy, varying definitions are sometimes 
used for the non-SI units of calories and Btu’s. When those units are used in this database, the conversion to 
and/or from SI units is based on the International Table calorie, defined by the Fifth International Conference 
on the Properties of Steam to be exactly 4.1868 joules. The corresponding International Table Btu is 
approximately 1055.056 joules. These values differ slightly from other common definitions, such as the 
“thermochemical” calorie that is defined as 4.184 joules. 
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The thermodynamic property formulation [1,2] is recommended for use at all temperatures greater than or 
equal to the melting or sublimation temperature at a given pressure (see Section A.7) and less than or equal 
to 1273.15 K, for all positive pressures up to 1000 MPa.  The extrapolation behavior of the formulation is 
reasonable; the NIST-10 database allows extrapolation in temperature up to 2000 K. 

The properties calculated by this database have associated uncertainties, arising from the precision and 
scatter of the underlying experimental data and from the fit of the formulation to those data. In general, 
information about these uncertainties may be found in the IAPWS release document for the property in 
question. However, since the thermodynamic properties are of interest to the most users and their 
uncertainties have been conveniently summarized in graphical form, we present here four figures, taken from 
the IAPWS release [1], which show the uncertainties for key thermodynamic properties as a function of 
pressure and temperature.  Information about uncertainty in calculated values of enthalpy may be found in 
an IAPWS document [9]. 

 

 

Figure A-1. Estimated uncertainties in density. In the enlarged critical region (triangle), a percent uncertainty 
in pressure is given. This region is bordered by the two isochores 527 kg·m-3 and 144 kg·m-3 and by the 30 
MPa isobar. The positions of the lines separating the uncertainty regions are approximate. 
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Figure A-2. Estimated uncertainties in speed of sound. For the definition of the region around the critical 
point, see Figure A-1. The positions of the lines separating the uncertainty regions are approximate. 
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Figure A-3. Estimated uncertainties in isobaric heat capacity cp. For the definition of the region around the 
critical point, see Figure A-1. The positions of the lines separating the uncertainty regions  are approximate. 
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Figure A-4. Estimated uncertainties in vapor pressure pσ, saturated liquid density ρ′, and saturated vapor 
density ρ″. 

 

A.2 Transport Properties 

The viscosity is calculated from the IAPWS Formulation 2008 for the Viscosity of Ordinary Water Substance 
[10,11].  The cited references may be consulted for information about the uncertainty of the viscosity 
formulation.  The region of validity of the formulation is defined as follows: 

273.16 K ≤ T ≤ 1173.15 K for  0 < p < pt 
Tm(p) ≤ T ≤ 1173.15 K for  pt ≤ p ≤ 300 MPa 
Tm(p) ≤ T ≤ 873.15 K for  300 MPa < p ≤ 350 MPa 
Tm(p) ≤ T ≤ 433.15 K for  350 MPa < p ≤ 500 MPa 
Tm(p) ≤ T ≤ 373.15 K for  500 MPa < p ≤ 1000 MPa, 

where pt is the triple-point pressure and Tm(p) the pressure-dependent melting temperature, computed by the 
formulation described in Section A.7. 

The thermal conductivity is calculated from the IAPWS Formulation 2011 for the Thermal Conductivity of 
Ordinary Water Substance [12,13].  The cited references may be consulted for information about the 
uncertainty of the thermal conductivity formulation.  The region of validity of the formulation is defined as 
follows: 
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0 < p < pt   and 273.16 ≤ T ≤ 1173.15 K 
pt ≤ p ≤ 100 MPa and  Tm(p) ≤ T ≤ 1173.15 K 
100 MPa < p ≤  250 MPa for  Tm(p) ≤ T ≤ 874 K 
250 MPa < p ≤  687 MPa for  Tm(p) ≤ T ≤ 573 K 
687 MPa < p ≤  785 MPa for  Tm(p) ≤ T ≤ 403 K 
785 MPa < p ≤  1000 MPa for  Tm(p) ≤ T ≤ 348 K, 

where pt is the triple-point pressure and Tm(p) the pressure-dependent melting temperature, computed by the 
formulation described in Section A.7. 

A.3 Static Dielectric Constant and Derivatives 

The static dielectric constant (or relative permittivity, where the permittivity of a vacuum is defined to be unity) 
is correlated as a function of temperature and density as described in the IAPWS Release on the Static 
Dielectric Constant of Ordinary Water Substance for Temperatures from 238 K to 873 K and Pressures up to 
1000 MPa [14,15].  This formulation contains a singularity at the temperature of 228 K; calculations at or 
below that temperature (which is only possible for vapors at extremely low pressures) return a value of “not 
applicable” for the dielectric constant.  Statements concerning the uncertainty of the formulation are given in 
the related references [14,15]. 

The database also calculates several derivatives of the dielectric constant.  These are the first derivative with 
respect to density at constant temperature, the first derivative with respect to temperature at constant 
density, and the first and second derivatives as a function of pressure and temperature. 

The so-called Debye-Hückel slopes, related to the dielectric constant and its derivatives, are used by solution 
chemists to describe the contributions of electrostatic effects to the thermodynamic properties of ionic 
solutions.  Definitions of these quantities may be found in [15].  This database computes the Debye-Hückel 
slopes for activity coefficient, osmotic coefficient, apparent molar volume, apparent molar enthalpy, apparent 
molar compressibility, and apparent molar heat capacity. 

The recommended range of the dielectric-constant formulation [14] is temperatures from 238 K to 873 K at 
pressures up to 1000 MPa. 

A.4 Refractive Index 

The refractive index (relative to a vacuum) is computed as a function of temperature, density, and 
wavelength according to the IAPWS Release on the Refractive Index of Ordinary Water Substance as a 
Function of Wavelength, Temperature, and Pressure [16,17]. This correlation is primarily intended for 
wavelengths in the visible region, but also extends somewhat into the ultraviolet and the near infrared.  
Statements concerning the uncertainty of the formulation are given in the related references [16,17]. 

The recommended range of the refractive-index formulation is temperatures from −12 °C to 500 °C and 
densities from zero to 1060 kg·m−3. The officially recommended range of wavelengths is from 0.2 µm to 1.1 
µm, and it extrapolates reasonably to 0.18 µm and to 1.9 µm, which is the range in which the database 
allows calculations. 

A.5 Surface Tension 

The surface tension between pure liquid water and pure water vapor is calculated according to the IAPWS 
1994 formulation for the Surface Tension of Ordinary Water Substance [18].  Information about uncertainty 
may be found in Ref. [18].  The range of validity is the entire vapor-liquid saturation curve, from the triple 
point at 273.16 K to the critical point at 647.096 K. 
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A.6 Self-ionization Constant 

The self-ionization constant (equilibrium constant for the reaction 2 32H O H O OH+ −+
) is computed from 

the IAPWS Release on the Ionization Constant of H2O [19,20].  The database computes the ionization 
equilibrium constant Kw, and also the quantity pKw ≡ −log10Kw.  The range of validity of the formulation is 
temperatures from 0 °C to 800 °C and densities from 0 to 1250 kg·m−3.  Uncertainties are described in the 
IAPWS document [19]. 

A.7 Sublimation and Melting Curves 

The sublimation (vapor-solid) and melting (liquid-solid) curves are computed according to the IAPWS 
Revised Release on the Pressure along the Melting and Sublimation Curves of Ordinary Water Substance 
[21,22].  The sublimation calculation is valid from 50 K to the triple point of 273.16 K, although the lower limit 
of calculations in the STEAM database is 130 K.  The melting curve describes the melting pressure as a 
function of temperature for liquid water in equilibrium with ice Ih and also with the high-pressure ice forms ice 
III, ice V, ice VI, and ice VII.  Note that some temperatures (between 251.165 K and 273.16 K) have points 
along two branches of the melting curve – a low-pressure root in equilibrium with ice Ih and a high-pressure 
root in equilibrium with ice III or ice V.  The database will display both roots in such cases, along with the ice 
form corresponding to each root.  
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Appendix B 
 

USING STEAM WITH OTHER PROGRAMS 
FORTRAN  SOURCE  CODE 

The calculation routines used for STEAM are for the most part a subset of those used for NIST’s REFPROP 
program (E.W. Lemmon, M.L. Huber, and M.O. McLinden, REFPROP: Reference Fluid Thermodynamic and 
Transport Properties, NIST Standard Reference Database 23, Version 9.1 (National Institute of Standards 
and Technology, Gaithersburg, MD, 2013)). 

The subroutines are contained in a number of files, which are placed in the NIST\STEAM\FORTRAN 
directory.  The following files should be compiled and linked with your own main program: 

core_anc.for  core_bwr.for   core_cpp.for   core_de.for    core_ecs.for 
core_feq.for  core_mlt.for   core_ph0.for   core_pr.for    core_stn.for    core_qui.for 
flash2.for    flsh_sub.for   idealgas.for   mix_aga8.for   mix_hmx.for 
prop_sub.for  realgas.for    sat_sub.for    setup.for      setup2.for      steam.for 
trns_ecs.for  trns_tcx.for   trns_vis.for   trnsp.for      utility.for 

These 26 files were compiled with the Lahey compiler using a command similar to this: 

lf95 core_anc.for -c -nco -nom -dll -win -ml msvb 

and linked with the following: 

lf95 pass_ftn.obj setup.obj core_anc.obj core_bwr.obj core_cpp.obj core_de.obj core_ecs.obj 
core_feq.obj core_mlt.obj core_ph0.obj core_qui.obj core_stn.obj core_pr.obj flash2.obj 
flsh_sub.obj idealgas.obj mix_aga8.obj mix_hmx.obj prop_sub.obj realgas.obj sat_sub.obj 
setup2.obj steam.obj trns_ecs.obj trns_tcx.obj trns_vis.obj trnsp.obj utility.obj   -nco -nom -dll -win -
ml msvb -out refprop.dll 

There is one additional file that comes with STEAM.  This file, called pass_ftn.for, is used only when creating 
the DLL. 

An example file showing how to call the routines is located in your STEAM\FORTRAN directory.  
EXAMPLE.FOR shows the common routines that you might need.   

The subroutine SETUP must be called to initialize the water data used by the software.  Subroutine 
SETPATH sets the path where the water.fld file can be found.   

B.1 Units 

All inputs and outputs to the subroutines are in the following units: 

temperature K 
pressure, fugacity kPa 
density mol/L 
composition mole fraction 
enthalpy, internal energy J/mol 
Gibbs, Helmholtz free energy J/mol 
entropy, heat capacity J/(mol⋅K) 
speed of sound m/s 
Joule-Thompson coefficient K/kPa 
d(p)/d(rho) kPa⋅L/mol 
d2(p)/d(rho)2 kPa⋅(L/mol)2 
viscosity µPa⋅s (10–6 Pa⋅s) 
thermal conductivity W/(m⋅K) 
dipole moment  debye 
surface tension N/m 
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Note:  The only exceptions to the above are the conversion utilities XMASS and XMOLE.  The graphical 
interface allows a wide variety of units, but not the subroutines. 

B.2 Naming Conventions  

The variable type of subroutine arguments can generally be inferred from the first letter of the variable name: 

a-g and o-z: double precision 
h: double precision (i.e. enthalpy) or character 
i-k and m,n: integer 
l: logical (within subroutines only, no logicals are used in arguments) also used as integer 

for exponent of FEQ model 

The property subroutines are compatible with FORTRAN 90. The routines are largely compatible with ANSI 
standard FORTRAN 77; the only extension widely used is the "do – enddo" construct, which is supported by 
most FORTRAN 77 compilers. We are striving to make these subroutines as standard and portable as 
possible, but every compiler has its own sensitive points. Please report any compiler or linker errors or 
warnings. 

The fluid data file water.fld is read using logical unit 12. Use of this unit in your application may crash the 
program and should be avoided. 

The file MANUAL.TXT located in your NIST\STEAM\FORTRAN directory contains a description of the high-
level subroutines that would be used in stand-alone applications. These subroutines will give you access to 
all features in a model-independent fashion. (There are corresponding low-level subroutines for some of 
these that call specific models. Please do not incorporate the low-level subroutines into your applications—if 
you do, you may find that future versions may not work the same.) 

B.3 Excel Spreadsheets 

The STEAM software includes dynamic link library ('.dll') support that allows a broad variety of applications to 
take advantage of STEAM capabilities.  STEAM is distributed with front-end software that links Microsoft 
Excel applications to fluid property functions. 

The Excel front-end is supplied as a Microsoft Visual Basic module.  Excel automatically incorporates Visual 
Basic as a macrofunction execution, scripting and interface utility.  When the STEAM front-end module is 
imported into an Excel spreadsheet, STEAM functions become accessible to the user.  The procedure for 
doing this is described below. 

The information given below demonstrates the front end usage; however, the user is not bound to this 
format; rather, the preferred method would be to write one's own visual basic code that calls the DLL directly.  
A dedicated module will increase the speed of the application and give the ability to use the STEAM 
functions to their fullest. 

The following supplementary instructions are intended for users who wish to create and modify their own 
spreadsheets that utilize the STEAM functions based on the front-end module.  The Excel application 
included with the software is called STEAM.xls and is located in the directory where the STEAM program 
was installed.  Sample FORTRAN and Visual Basic files are also included. 

Properties are calculated by calling various functions.  For example, the following line would be placed in a 
cell to calculate the density of water at 300 K and 10 MPa: 

=Density("TP","SI",300,10) 

Other properties can be calculated by using any of the following functions: 
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Temperature IsentropicExpansionCoef 
Pressure IsothermalCompressibility 
Density VolumeExpansivity 
CompressibilityFactor AdiabaticCompressibility 
LiquidDensity AdiabaticBulkModulus 
VaporDensity IsothermalExpansionCoef 
Volume IsothermalBulkModulus 
Energy Viscosity 
Enthalpy ThermalConductivity 
Entropy Prandtl 
IsochoricHeatCapacity (or Cv) SurfaceTension 
IsobaricHeatCapacity (or Cp) DielectricConstant 
SpeedOfSound (or Sound) EOSMax 
Quality EOSMin 
HeatOfVaporization (or LatentHeat) dPdrho 
JouleThompson dPdT 
MolarMass Cstar (critical flow factor) 
d2Pdrho2 Fugacity 
drhodT FugacityCoefficient 
SpecificHeatInput Chemical Potential 

 

The first input to the function is the combination of input properties being sent to the function.  Thus, for a 
given pressure and temperature, the second input would be "PT" (or "TP", depending on the order in which 
the properties are sent).  Other valid inputs include the density (D), energy (E), enthalpy (H), entropy (S), and 
quality (Q).  Valid combinations include: TP, TD, TH, TS, TE, TQ, PD, PH, PS, PE, PQ, DH, DS, DE, and HS.  
For saturation states, the second input is Tliq or Tvap for a given saturated temperature, Pliq or Pvap for a 
given saturated pressure, or Dliq or Dvap for a saturated density.  Liquid properties are returned when these 
inputs contain "liq" and vapor properties are returned when "vap" is used. 

The second input to the property functions defines the units.  This input can be one of the following:  "SI", "SI 
with C", "Molar SI", "E", "cgs", "mks", "M".  If left blank, the default is SI.  The "SI with C" input can be shorted 
to just "C".  The units that correspond to these inputs are: 

SI: K, MPa, kg/m^3, kJ/kg, kJ/kg-K, m/s, µPa-s, mW/m-K, mN/m 
SI with C: C, MPa, kg/m^3, kJ/kg, kJ/kg-K, m/s, µPa-s, mW/m-K, mN/m 
Molar SI: K, MPa, mol/dm^3, J/mol, J/mol-K, m/s, µPa-s, mW/m-K, mN/m 
mks: K, kPa, kg/m^3, kJ/kg, kJ/kg-K, m/s, µPa-s, W/m-K, mN/m 
cgs: K, MPa, g/cm^3, J/g, J/g-K, cm/s, µPa-s, mW/m-K, dyn/cm 
E: F, psia, lbm/ft^3, Btu/lbm, Btu/lbm-R, ft/s, lbm/ft-s, Btu/h-ft-F, lbf/ft 
M: K, psia, g/cm^3, J/g, J/g-K, m/s, µPa-s, mW/m-K, mN/m 

For example, the following line would be placed in a cell to calculate the density at 100 F and 250 psia (the 
result will be in units of lbm/ft^3): 

=Density("TP","E",100,250) 

The independent variables in the equation of state used in STEAM are temperature and density.  If more 
than one property is needed, it is best to first determine these quantities from the given set of initial inputs, 
and then determine the other properties.  This will greatly speed up the calculation.  This is particularly 
important when properties for pure fluids that are within the two-phase region are calculated.  For example, 
to calculate the energy, enthalpy, and entropy given the pressure and quality of a two-phase system, place 
the pressure in cell A1 and the quality in B1.  Put the following in cells A2 through A5: 

=Temperature("PQ","SI",$A$1,$B$1) 
=Density("PQ","SI",$A$1,$B$1) 
=Energy("TD","SI",$A$2,$A$3) 
=Enthalpy("TD","SI",$A$2,$A$3) 
=Entropy($A$1,"TD","SI",$A$2,$A$3) 



 

 STEAM 40 

The functions LiquidDensity and VaporDensity will return the saturated liquid and vapor densities of a two-
phase state.  These densities, along with the temperature, can then be used to calculate all other 
thermodynamic and transport properties at the saturation boundaries using the functions outlined above. 

The inputs "Tmelt", "Pmelt", "Tsubl", and "Psubl" return melting line or sublimation line values.  To calculate 
the melting pressure at 280 K, enter: 

=Pressure("Tmelt","SI",280) 

To calculate the melting temperature, enter "Pmelt" as the first input and the melting pressure as the third 
input. 

=Temperature("Pmelt","SI",25) 

The critical point or triple point is returned in a similar manner via the inputs "crit" or "trip", along with input of 
the units.  All of these functions are shown in the STEAM.xls file. 

STEAM can be permanently linked to EXCEL by following these steps: 

(This documentation assumes that the STEAM files have been installed in the "C:\Program 
Files\NIST\STEAM" directory.  Other installations require appropriate adjustments.) 

First, execute either step #1 or step #2 (#1 is preferred): 

1.  Two environment variables can be set to specify the locations of the fluid files and the DLL.  This can be 
done under Start/Settings/Control Panel/System/Advanced/Environment Variables.  A new variable called 
STprefix should be created with a value of "C:\Program Files\NIST\STEAM" (or the directory where STEAM 
is located).  If the Path variable does not exist, create one and add the same directory as you did for 
STprefix.  If the path variable does exist, it should be modified by adding ";c:\Program Files\NIST\STEAM" to 
the end so that the REFPROP.DLL file can be found from any location.   

2.  From EXCEL open the file STEAM.xls.  Open the VB-editor with 'Alt-F11'.  Scroll to the top of the module 
and read the comments.   Make the necessary directory changes as described.   The lines should look like 
this: 

. 

. 
Public Const FluidsDirectory As String =  "c:\program files\NIST\STEAM\" 
. 
. 

The path marked "c:\..." must point exactly to the location where the STEAM fluid file (WATER.FLD) is stored 
on the user's disk drive.  Scroll down and follow the instructions about specifying the path for the DLL by 
replacing all occurrences of "REFPROP.DLL" with "C:\Program Files\NIST\STEAM\REFPROP.DLL".  Quit 
the VB-editor and return to EXCEL and save STEAM.xls. 

3.  Save the STEAM.xls file as a Microsoft Excel Add-In (named STEAM.xla).  The default location will 
appear as something like ...\Microsoft\AddIns.  The file should be saved in this directory.   Alternatively, do a 
search on your computer for the *.xla files and put the STEAM.xla file in with the others. 

4.  Open EXCEL with an empty spreadsheet and find under 'Tools' the Add-Ins Manager. Find on the list of 
available Add-Ins the new entry STEAM AddIns'. Mark it as active and exit the Add-Ins Manager. 

5. Now open any EXCEL spreadsheet, go to any cell and type something like: 

=density("TP","SI",500,100) 
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6.  If you need to edit the .xla file after it has been installed, reopen the STEAM.xls file, edit the VB section, 
then save it as .xls.  Under 'Tools' go to the Add-Ins Manager and deselect the STEAM AddIn.  Then save 
the file again as .xla. 

7.  Once the module has been imported into a spreadsheet, the STEAM functions may be selected by using 
the pull-down function list.  When editing the formula in a cell, select More Functions from the pull-down list 
and scroll down the Function Category list to select the User Defined functions.  The argument editor will 
prompt for STEAM function arguments as it does for standard Excel functions. 

B.4 Warning and Error Messages 

The FORTRAN routines return warning and error codes and messages when the input conditions are out of 
range or the calculations fail. The error codes are integers returned in the subroutine argument ierr. When a 
calculation is successful, the value of ierr is 0. Negative values of ierr signify a warning—that is, a condition 
where calculations were completed, but the results may be suspect. The most common warning would be for 
a temperature or pressure slightly above the limits of the property model. 

Errors imply conditions for which the calculations failed (such as an iteration not converging) or for which 
calculations are not possible (such as a negative pressure). Many property models give nonsensical results 
when extrapolated to lower temperatures and/or higher densities; thus errors are also issued when the 
temperature is below the limit of the model or the density is above the limit. The codes for errors are positive 
numbers. 

More detailed messages (including, in some cases, a report of the input condition(s) that resulted in the 
warning or error) are available via the output variable herr, which may be printed or displayed using the 
subroutine ERRMSG. In the graphical interface, errors are displayed in an Alert box. If the calculation of a 
table results in a warning, a message is displayed at the completion of the calculations, and the individual 
messages can be displayed by clicking the mouse on the number of the affected row. 

B.5 Linking with other Applications 

Because the STEAM program uses the same basic structure as NIST’s REFPROP program, work that 
others have done for linking REFPROP to other software applications (C, LabView, MatLab, etc.) can 
probably be adapted for STEAM with only minor modifications.  Information about these and other 
applications, some developed at NIST and some elsewhere, may be found on the REFPROP FAQ page at 
http://www.boulder.nist.gov/div838/theory/refprop/Frequently_asked_questions.htm. 
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Appendix C 
 

USE OF ALTERNATE (OBSOLETE) FORTRAN CODE 
 

Versions 2.0 through 2.22 of the NIST/ASME Steam Properties database made use of Fortran subroutines 
specially written for NIST-10.  For an additional fee, purchasers of the database could receive that Fortran 
code for incorporation into their own software.  Starting with Version 3.0, the underlying calculational code is 
adopted from NIST’s REFPROP database, as described in Appendix B.  New purchasers of STEAM wishing 
to incorporate the software into their own calculations should use the code and procedures described in 
Appendix B. 

However, for backward compatibility, we are also including Fortran code in the “old” format (this code may be 
found in the NIST\STEAM\OLDFORT subdirectory).  This is a minor update of the Fortran code that 
accompanied Version 2.22, mainly reflecting changes in IAPWS standards for thermal conductivity and for 
the melting and sublimation curves adopted in the meantime.  This code should give results consistent 
(within small differences due to different numerical procedures) with the code used in Version 3.0, although 
some of the properties calculated in Version 3.0 (such as Prandtl number and ionization constant) are not 
available in this backward-compatible Fortran code.  For users who have already incorporated previous 
versions of NIST code in software, it may be advisable to use this code. 

The remainder of Appendix C documents how to use these backwards-compatible subroutines. 

It is anticipated that no further updates will be made to this “old” code beyond Version 3.0. 

C.1 Description of Code 

All the source code for the calculations is written in the Fortran 77 language and is compatible with Fortran 
90 and Fortran 95. The Fortran source code is divided into five sets of subroutines, as follows: 

• AUXPK.FOR Miscellaneous subroutines used in the calculations 

• EOSPK.FOR Subroutines used to evaluate the fundamental equation of state 

• INTPK.FOR “Interface” subroutines that accept input in SI units, call the appropriate routines and 
return values in SI units. The subroutines in INTPK are the only ones that should 
ever be called from another program. 

• PROPPK.FOR Subroutines to calculate various fluid properties. 

• SOLVPK.FOR Subroutines to solve various sets of conditions, such as finding the vapor pressure at a 
given temperature. 

There are also five common blocks used by the subroutines: COEF.CMN, COEFIG.CMN, NPROP.CMN, 
WCONST.CMN, and WLIMIT.CMN. These common blocks must be accessible by INCLUDE statements 
whenever a subroutine is compiled. This is most easily accomplished by putting them in the same directory 
as the source routine. 

All calculations should be performed by calling the appropriate subroutine in INTPK. You should not 
need to call directly any subroutine in any of the other sets of subroutines. Those subroutines 
should simply be compiled as is and linked in with the program. 

C.2 Interface Subroutines 

INTPK.FOR contains twelve subroutines through which the STEAM database communicates with the outside 
world. Here, we list the subroutines and document their argument lists. Note that many of the arrays passed 
to these routines have a dimension of NPROP, where NPROP (the length of the property array) is set in 
NPROP.CMN. NPROP.CMN also contains the dimension NRIMAX, which is the maximum number of 
wavelengths at which the refractive index may be calculated and is needed for some arrays passed to the 
PROPS subroutine.  
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The “TYPE” of each argument is R (double precision real), I (integer), RA (double precision real array), or IA 
(integer array).  The “I/O” column tells whether an argument is input (I) to the subroutine or output (O) from 
the subroutine. In a few cases a dash appears; this indicates an argument that is used only as internal 
workspace by the routine. 

 

BNDCK: Checks to see if conditions are outside of warning and/or error limits. 
      SUBROUTINE BNDCHK(TK, PMPA, RHO, MODE, ISCHK, ISFLG, ICCHK, ICFLG, 
     >                  IPCHK, IPFLG, IWORK, PROPSI, RWORK) 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
C                   *** BNDCHK ***                                    C 
C THIS ROUTINE CHECKS TO SEE IF THE REQUESTED POINT IS AN             C 
C EXTRAPOLATION OR OUT OF RANGE FOR A VARIETY OF CRITERIA             C 
C                                                                     C 
C ARGUMENT LIST:                                                      C 
C  NAME  TYPE I/O? EXPLANATION                                        C 
C------ ----- ---- -------------------------------------------------- C 
C TK      R    I   TEMPERATURE IN KELVINS                             C 
C PMPA    R    I   PRESSURE IN MPA                                    C 
C RHO     R    I   DENSITY IN KG/M3                                   C 
C MODE    I    I   TELLS WHAT INFORMATION IS AVAILABLE ON ENTRY       C 
C                  0: T, P, RHO ALL KNOWN                             C 
C                  1: T AND P KNOWN, RHO UNKNOWN                      C 
C                  2: T AND RHO KNOWN, P UNKNOWN                      C 
C *** NOTE: FOLLOWING ARE FLAGS FOR WHETHER TO MAKE A CHECK (1=CHECK, C 
C           0=DON'T) AND FLAGS RETURNED FROM THE CHECKS (0=OK OR NOT  C 
C           CHECKED, 1=EXTRAPOLATED BEYOND RECOMMENDED REGION, 2=     C 
C           UNACCEPTABLY OUTSIDE OF REGION                            C 
C ISCHK   I    I   WHETHER TO CHECK IF EQUILIBRIUM PHASE IS SOLID     C 
C ISFLG   I    O   RESULT OF SOLID CHECK                              C 
C ICCHK   I    I   WHETHER TO CHECK IF TOO NEAR CRITICAL POINT        C 
C ICFLG   I    O   RESULT OF NEAR CRITICAL CHECK                      C 
C IPCHK   IA   I   WHETHER TO CHECK BOUNDARIES FOR VARIOUS            C 
C                  PROPERTIES.                                        C 
C                   ARRAY ELEMENTS ARE: 1: THERMODYNAMIC PROPERTIES   C 
C                                      2: VISCOSITY                   C 
C                                      3: THERMAL CONDUCTIVITY        C 
C                                      4: DIELECTRIC CONSTANT         C 
C                                      5: REFRACTIVE INDEX            C 
C IPFLG   IA   O   RESULTS OF PROPERTY BOUNDARY CHECKS                C 
C IWORK   IA       INTEGER WORK ARRAY, USED IF P GETS CALCULATED      C 
C PROPSI  RA   O   VECTOR OF PROPERTIES IN SI UNITS AS REQUESTED BY   C 
C                  IWANT.  NUMBERING OF PROPERTIES:                   C 
C                  2: PRESSURE IN MPA                                 C 
C RWORK   RA       REAL WORK ARRAY, USED IF P GETS CALCULATED         C 
 

DENS, DENS0:  Solve for density given T and P.  DENS requires an initial guess. 
 
      SUBROUTINE DENS(DOUT, PMPA, D, TK, DPD, IWORK, PROPR, IERR) 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
C                     *** DENS  ***                                  C 
C THIS ROUTINE FINDS THE DENSITY (IN KG/M3) CORRESPONDING TO A GIVEN C 
C TEMPERATURE TK (IN K) AND PRESSURE PMPA (IN MPA).  AN              C 
C INITIAL GUESS (D) IS REQUIRED, AND THE VALUE OF DPDD IS ALSO       C 
C RETURNED.                                                          C 
C                                                                    C 
C ARGUMENT LIST:                                                     C 
C  NAME  TYPE I/O? EXPLANATION                                       C 
C ------ ---- ---- ------------------------------------------------  C 
C DOUT    R   O   DENSITY AT TK AND PMPA, KG/M3                      C 
C PMPA    R   I   PRESSURE, MPA                                      C 
C D       R   I   INITIAL GUESS FOR DENSITY, KG/M3                   C 
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C TK      R   I   TEMPERATURE, K                                     C 
C DPD     R   O   FIRST DERIVATIVE OF PMPA WITH RESPECT TO D AT DOUT C 
C IWORK   IA  -   INTEGER VECTOR FOR USE BY LOWER-LEVEL ROUTINES     C 
C PROPR   RA  -   VECTOR OF REDUCED PROPERTIES USED BY LOWER-LEVEL   C 
C                  ROUTINES                                          C 
C IERR    I    O   DFIND RETURN STATUS FLAG.  NEGATIVES FROM DFIND1, C 
C                  POSITIVES FROM DFIND2.  MEANINGS:                 C 
C                  0: CONVERGED                                      C 
C                 -2: UNABLE TO BOUND ROOT (DFIND1)                  C 
C                 -3: UNABLE TO CONVERGE BOUNDED ROOT (DFIND1)       C 
C                  1: NO ROOT FOR REQUESTED PHASE.  RETURNS D WHERE  C 
C                     DPD = 0 (DFIND2)                               C 
C                  2: UNABLE TO BOUND ROOT (DFIND2)                  C 
C                  3: UNABLE TO CONVERGE BOUNDED ROOT (DFIND2)       C 
C                  5: INPUT PRESSURE NOT IN VALID RANGE              C 
C                  6: INPUT TEMPERATURE NOT IN VALID RANGE           C 
C                  7: INPUT T,P TOO FAR IN SUBCOOLED SOLID REGION.   C 
C                     CALCULATIONS ABORTED                           C 
 
      SUBROUTINE DENS0(DOUT, PMPA, TK, DPD, IWORK, PROPR, IERR) 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
C                     *** DENS0 ***                                  C 
C THIS ROUTINE FINDS THE DENSITY (IN KG/M3) CORRESPONDING TO A GIVEN C 
C TEMPERATURE (IN K) TK AND PRESSURE (IN MPA) PMPA.  IN              C 
C CONTRAST TO DENS, NO INITIAL GUESS IS REQUIRED (ONE IS GENERATED   C 
C INTERNALLY).  THE VALUE OF DPD IS ALSO RETURNED.                   C 
C                                                                    C 
C  NAME  TYPE I/O? EXPLANATION                                       C 
C ------ ---- ---- ------------------------------------------------  C 
C DOUT    R   O   DENSITY AT TK AND PMPA, KG/M3                      C 
C PMPA    R   I   PRESSURE, MPA                                      C 
C TK      R   I   TEMPERATURE, K                                     C 
C DPD     R   O   FIRST DERIVATIVE OF PMPA WITH RESPECT TO D AT DOUT C 
C IWORK   IA  -   INTEGER VECTOR FOR USE BY LOWER-LEVEL ROUTINES     C 
C PROPR   RA  -   VECTOR OF REDUCED PROPERTIES USED BY LOWER-LEVEL   C 
C                 ROUTINES                                           C 
C IERR    I   O   DFIND0 RETURN STATUS FLAG.  NEGATIVES FROM DFIND1, C 
C                  POSITIVES FROM DFIND2.  MEANINGS:                 C 
C                  0: CONVERGED                                      C 
C                 -2: UNABLE TO BOUND ROOT (DFIND1)                  C 
C                 -3: UNABLE TO CONVERGE BOUNDED ROOT (DFIND1)       C 
C                  1: NO ROOT FOR REQUESTED PHASE.  RETURNS D WHERE  C 
C                     DPD = 0 (DFIND2)                               C 
C                  2: UNABLE TO BOUND ROOT (DFIND2)                  C 
C                  3: UNABLE TO CONVERGE BOUNDED ROOT (DFIND2)       C 
C                  5: INPUT PRESSURE NOT IN VALID RANGE              C 
C                  6: INPUT TEMPERATURE NOT IN VALID RANGE           C 
C                  7: INPUT T,P TOO FAR IN SUBCOOLED SOLID REGION.   C 
C                     CALCULATIONS ABORTED                           C 
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HSSOLV:  Solve for temperature given pressure and entropy or enthalpy; solve for pressure given 
temperature and entropy. 
 
      SUBROUTINE HSSOLV(MODE, TP, HS, TPOUT, D1, DV, DL, I2PH, Q,  
     >                  IWORK, PROPR, IERR) 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
C                     *** HSSOLV ***                                   C 
C THIS ROUTINE SOLVES FOR THE CORRESPONDING T OR P FOR SPECIFIED       C 
C P/H, P/S, OR T/S.  IT ALSO RETURNS THE DENSITY AT THE SOLUTION (OR   C 
C DENSITIES FOR 2-PHASE SOLUTION) AND QUALITY.  THE ROUTINES THAT IT   C 
C CALLS GET PASSED LIMITS WHICH ARE CHECKED.                           C 
C                                                                      C 
C ARGUMENT LIST:                                                       C 
C  NAME  TYPE I/O? EXPLANATION                                         C 
C ------ ---- ---- --------------------------------------------------  C 
C MODE    I    I   1 = GIVEN P/H, SOLVE FOR T                          C 
C                  2 = GIVEN P/S, SOLVE FOR T                          C 
C                  3 = GIVEN T/S, SOLVE FOR P                          C 
C TP      R    I   DEPENDING ON MODE, EITHER T(K) OR P(MPA)            C 
C HS      R    I   DEPENDING ON MODE, EITHER H(KJ/KG) OR S (KJ/KG.K)   C 
C TPOUT   R    O   SOLUTION FOR T(K) OR P(MPA)                         C 
C D1      R    O   DENSITY (KG/M3) IF SOLUTION IN 1-PHASE REGION       C 
C DV      R    O   VAPOR DENSITY (KG/M3) IF SOLUTION IN 2-PHASE REGION C 
C DL      R    O   LIQ. DENSITY (KG/M3) IF SOLUTION IN 2-PHASE REGION  C 
C I2PH    I    O   OUTPUT FLAG FOR RELATION TO 2-PHASE REGION          C 
C                  0 = NO SOLUTION FOUND                               C 
C                 -1 = SUBCOOLED LIQUID (ALSO T<TC AND P>PC)           C 
C                  1 = SUPERHEATED VAPOR (ALSO T>TC)                   C 
C                  2 = SOLUTION IN TWO-PHASE REGION                    C 
C                  3 = UNABLE TO PERFORM 2-PHASE ANALYSIS BECAUSE P    C 
C                      TOO LOW FOR SAT. CALC.  TREATED AS 1-PHASE      C 
C                  4 = SAME AS 2, EXCEPT 2-PHASE ENVELOPE EXTRAPOLATED C 
C                      TO REGION BELOW TRIPLE POINT                    C 
C Q       R    O   QUALITY (VAPOR/TOTAL) AT SOLUTION.  IF SOLUTION IS  C 
C                  1-PHASE, RETURNS 1.0 FOR SUPERCRITICAL ISOBAR OR    C 
C                  ISOTHERM.  FOR 1-PHASE ON SUBCRITICAL ISOBAR OR     C 
C                  ISOTHERM, RETURNS 1.0 FOR VAPOR OR 0.0 FOR LIQUID.  C 
C IWORK   IA   -   INTEGER VECTOR FOR USE BY LOWER-LEVEL ROUTINES      C 
C PROPR   RA   -   VECTOR OF REDUCED PROPERTIES USED BY LOWER-LEVEL    C 
C                  ROUTINES                                            C 
C IERR    I    O   RETURN STATUS CODE                                  C 
C                  0: CONVERGED                                        C 
C                  1: NO SOLUTION INSIDE VALID RANGE                   C 
C                  2: SOLUTION EXTRAPOLATED OUTSIDE RECOMMENDED RANGE  C 
C                     (EXTRAPOLATION INTO FLUID REGION)                C 
C                  3: UNABLE TO CONVERGE BOUNDED ROOT                  C 
C                  4: SOLUTION EXTRAPOLATED OUTSIDE RECOMMENDED RANGE  C 
C                     (EXTRAPOLATION INTO EQUILIBRIUM SOLID REGION)    C 
C                  5: INPUT PRESSURE NOT IN VALID RANGE                C 
C                  6: INPUT TEMPERATURE NOT IN VALID RANGE             C 
C                  7: CALLED WITH INVALID MODE                         C 
C                                                                      C 
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PMELT, TMELT:  Solve for liquid-solid saturation (melting) curve. 
 
      SUBROUTINE PMELT(TK, NROOTS, PMPA1, PMPA2, IFORM, IERR) 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
C                     *** PMELT ***                                  C 
C THIS ROUTINE GIVES THE MELTING PRESSURE(S) PMPA AS A FUNCTION OF   C 
C TEMPERATURE TK USING THE IAPWS 2008 EQUATIONS. ALL FORMS OF ICE ARE C 
C CONSIDERED, SO IT IS POSSIBLE TO HAVE TWO ROOTS.                   C 
C                                                                    C 
C ARGUMENT LIST:                                                     C 
C  NAME  TYPE I/O? EXPLANATION                                       C 
C ------ ---- ---- ------------------------------------------------  C 
C TK      R   I  TEMPERATURE IN K                                    C 
C NROOTS  I   O  NUMBER OF PRESSURES AT WHICH MELTING HAPPENS AT TK  C 
C PMPA1   R   O  MELTING PRESSURE IN MPA FOR FIRST ROOT, IF ANY      C 
C PMPA2   R   O  MELTING PRESSURE IN MPA FOR SECOND ROOT, IF ANY     C 
C                 IF 2 ROOTS, PMPA1 HAS LOWEST PRESSURE (ICE I)      C 
C IFORM   I   O  FORM OF ICE WITH WHICH FLUID COEXISTS.  IF NROOTS   C 
C                 IS 2, THIS CONTAINS THE HIGH-PRESSURE FORM SINCE   C 
C                 ROOT 1 MUST BE ICE I.                              C 
C IERR    I   O  RETURN CODE:                                        C 
C                 0 = SUCCESS                                        C 
C                 1 = TEMPERATURE BELOW VALID RANGE (251.165 K)      C 
C                 2 = TEMPERATURE ABOVE VALID RANGE (715. K)         C 
C                  IF 1 OR 2, PMPA IS RETURNED AS ZERO               C 
 
      SUBROUTINE TMELT(TK, PMPA, IFORM, IERR) 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
C                     *** TMELT ***                                  C 
C THIS ROUTINE GIVES THE MELTING TEMPERATURE TK AS A FUNCTION OF     C 
C PRESSURE PMPA USING THE IAPWS 2008 EQUATIONS. IT ITERATIVELY       C 
C CALLS PMELT1 (FOR ICE I) OR PMELT2 (FOR HIGH-PRESSURE FORMS).      C 
C                                                                    C 
C ARGUMENT LIST:                                                     C 
C  NAME  TYPE I/O? EXPLANATION                                       C 
C ------ ---- ---- ------------------------------------------------  C 
C TK      R    O   MELTING TEMPERATURE IN K                          C 
C PMPA    R    I   PRESSURE IN MPA                                   C 
C IFORM   I    O   NUMBER OF ICE FORM INVOLVED IN THE EQUILIBRIUM    C 
C IERR    I    O   RETURN CODE:                                      C 
C                  0 = SUCCESS                                       C 
C                  1 = PRESSURE BELOW VALID RANGE (611.657D-6 MPA)   C 
C                  2 = PRESSURE ABOVE VALID RANGE (20618 MPA)        C 
C                  IF 1 OR 2, TMIN OR TMAX IS RETURNED               C 
 
 
PROPS:  Compute fluid properties at a given temperature and density. 
 
      SUBROUTINE PROPS(IWANT, TK, RHO, PROPSI, PROPR, I2PHCK, I2PH, 
     >             ISCHK, ISFLG, ICCHK, ICFLG, IPCHK, IPFLG, IGFLG, 
     >             NRI, WAVRI, RI, IRIFLG) 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
C                     *** PROPS ***                                  C 
C THIS ROUTINE COMPUTES ALL PROPERTIES REQUESTED VIA THE IWANT VECTORC 
C AT A GIVEN TEMPERATURE AND DENSITY.  PROPERTIES ARE RETURNED IN SI C 
C UNITS: KG, M3, K, MPA, KJ.  THE LOWER LEVEL ROUTINE PROPS1 IS      C 
C CALLED TO RETURN THE PROPERTIES. IT ALSO CHECKS TO SEE IF THE POINTC 
C IS IN THE 2 PHASE REGION AND RETURNS THE APPROPRIATE QUALITY AND   C 
C BULK PROPERTIES.  BOUNDS CHECKING IS ALSO DONE HERE IF REQUESTED   C 
C                                                                    C 
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C ARGUMENT LIST:                                                     C 
C  NAME  TYPE I/O? EXPLANATION                                       C 
C                                                                    C 
C IWANT   IA   I   FOR WHETHER OR NOT TO COMPUTE VARIOUS PROPERTIES, C 
C                  SEE PROPSI ARRAY BELOW FOR NUMBERING OF PROPERTIESC 
C                  1=COMPUTE, 0=DON'T COMPUTE                        C 
C TK      R    I   TEMPERATURE IN KELVINS                            C 
C RHO     R    I   DENSITY IN KG/M3                                  C 
C PROPSI  RA   O   VECTOR OF PROPERTIES IN SI UNITS AS REQUESTED BY  C 
C                  IWANT.  NUMBERING OF PROPERTIES:                  C 
C                  1: TEMPERATURE IN K                               C 
C                  2: PRESSURE IN MPA                                C 
C                  3: DENSITY IN KG/M3                               C 
C                  4: VOLUME IN M3/KG                                C 
C                  5: QUALITY (ONLY SET IF 2 PHASE)                  C 
C                  6: ENTHALPY IN KJ/KG                              C 
C                  7: ENTROPY IN KJ/(KG*K)                           C 
C                  8: ISOCHORIC HEAT CAPACITY IN KJ/(KG*K)           C 
C                  9: ISOBARIC HEAT CAPACITY IN KJ/(KG*K)            C 
C                 10: INTERNAL ENERGY IN KJ/KG                       C 
C                 11: HELMHOLTZ ENERGY IN KJ/KG                      C 
C                 12: GIBBS ENERGY IN KJ/KG                          C 
C                 13: FUGACITY IN MPA                                C 
C                 14: ISOTHERMAL COMPRESSIBILITY IN MPA**( 1)        C 
C                 15: VOLUME EXPANSIVITY IN K**( 1)                  C 
C                 16: DP/DRHO (CONSTANT T) IN MPA/(KG/M3)            C 
C                 17: DP/DT (CONSTANT RHO) IN MPA/K                  C 
C                 18: SPEED OF SOUND IN M/SEC                        C 
C                 19: JOULE THOMSON COEFFICIENT IN K/MPA             C 
C                 20: THERMAL CONDUCTIVITY IN W/M K                  C 
C                 21: VISCOSITY IN PA SEC                            C 
C                 22: STATIC DIELECTRIC CONSTANT (RETURNED AS 999. IFC 
C                     CALCULATION COULD NOT BE DONE)                 C 
C                 23: 2ND DERIVATIVE D2P/DRHO2 (CONSTANT T) IN       C 
C                     MPA/(KG/M3)**2                                 C 
C                 24: 2ND DERIVATIVE D2P/DT2 (CONSTANT RHO)          C 
C                     IN MPA/K**2                                    C 
C                 25: 2ND DERIVATIVE D2P/DRHODT (CONSTANT T, RHO)    C 
C                     IN MPA/(KG/M3)/K                               C 
C                 26: DRHO/DT (CONSTANT P) IN (KG/M3)/K              C 
C                 27: DRHO/DP (CONSTANT T) IN (KG/M3)/MPA            C 
C                 28: 2ND DERIVATIVE D2RHO/DT2 (CONSTANT P)          C 
C                     IN (KG/M3)/K**2                                C 
C                 29: 2ND DERIVATIVE D2RHO/DP2 (CONSTANT T)          C 
C                     IN (KG/M3)/MPA**2                              C 
C                 30: 2ND DERIVATIVE D2RHO/DTDP (CONSTANT P, T)      C 
C                     IN (KG/M3)/K/MPA                               C 
C                 31: DIELECTRIC DERIVATIVE D(EPS)/D(RHO)(CONSTANT T)C 
C                     IN M3/KG                                       C 
C                 32: DIELECTRIC DERIVATIVE D(EPS)/DT (CONSTANT RHO) C 
C                     IN K**( 1)                                     C 
C                 33: DIELECTRIC DERIVATIVE D(EPS)/DT (CONSTANT P)   C 
C                     IN K**( 1)                                     C 
C                 34: DIELECTRIC DERIVATIVE D(EPS)/DP (CONSTANT T)   C 
C                     IN MPA**( 1)                                   C 
C                 35: 2ND DIELECTRIC DERIVATIVE D2(EPS)/DT2(CONST. P)C 
C                     IN K**( 2)                                     C 
C                 36: 2ND DIELECTRIC DERIVATIVE D2(EPS)/DP2(CONST. T)C 
C                     IN MPA**( 2)                                   C 
C                 37: 2ND DIELECTRIC DERIVATIVE D2(EPS)/DTDP         C 
C                     (CONSTANT P, T) IN (K*MPA)**( 1)               C 
C                 38: DEBYE HUCKEL SLOPE FOR ACTIVITY COEFFICIENT    C 
C                     IN (KG/MOL)**0.5                               C 
C                 39: D H SLOPE FOR OSMOTIC COEFF. IN (KG/MOL)**0.5  C 
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C                 40: D H SLOPE FOR APPARENT MOLAR VOLUME            C 
C                     IN (M3/MOL)*(KG/MOL)**0.5                      C 
C                 41: D H SLOPE FOR APPARENT MOLAR ENTHALPY, DIVIDED C 
C                     BY RT, IN (KG/MOL)**0.5                        C 
C                 42: D H SLOPE FOR APPARENT MOLAR COMPRESSIBILITY   C 
C                     IN (M3/MOL/MPA)*(KG/MOL)**0.5                  C 
C                 43: D H SLOPE FOR APPARENT MOLAR HEAT CAPACITY,    C 
C                     DIVIDED BY R, IN (KG/MOL)**0.5                 C 
C PROPR   RA     WORK VECTOR FOR REDUCED PROPERTIES PASSED TO PROPSL C 
C I2PHCK  I    I FLAG FOR WHETHER TO CHECK AND SEE IF REQUESTED T ANDC 
C                 RHO IN 2 PHASE REGION.  0=DON'T CHECK, 1=CHECK     C 
C I2PH    I    O  OUTPUT FLAG FOR RELATION TO 2 PHASE REGION         C 
C                 0 = I2PHCK=0 (OR IDEAL GAS)                        C 
C                 1 = SUBCOOLED LIQUID (ALSO T<TC AND P>PC)          C 
C                 1 = SUPERHEATED VAPOR (ALSO T>TC)                  C 
C                 2 = 2 PHASE REGION. QUALITY IS PUT IN SLOT 5, PROPSC 
C                     RETURNED IN PROPSI ARE APPROPRIATE AVERAGES.FORC 
C                     PROPS THAT CAN'T BE AVERAGED, ZERO IS RETURNED C 
C                 3 = UNABLE TO PERFORM 2 PHASE CHECK BECAUSE TK     C 
C                     BELOW MINIMUM. PROPS RETURNED AS THOUGH 1 PHASEC 
C                 4 = SAME AS 2, EXCEPT 2 PHASE ENVELOPE EXTRAPOLATEDC 
C                     TO REGION BELOW TRIPLE POINT                   C 
C *** NOTE:  FOLLOWING ARE FLAGS FOR WHETHER TO MAKE A CHECK(1=CHECK,C 
C            0=DON'T) AND FLAGS RETURNED FROM THE CHECKS (0=OK OR NOTC 
C            CHECKED, 1=EXTRAPOLATED BEYOND RECOMMENDED REGION, 2=   C 
C            UNACCEPTABLY OUTSIDE OF REGION                          C 
C ISCHK   I    I   WHETHER TO CHECK IF EQUILIBRIUM PHASE IS SOLID    C 
C ISFLG   I    O   RESULT OF SOLID CHECK                             C 
C ICCHK   I    I   WHETHER TO CHECK IF TOO NEAR CRITICAL POINT       C 
C ICFLG   I    O   RESULT OF NEAR CRITICAL CHECK                     C 
C IPCHK   IA   I   WHETHER TO CHECK BOUNDARIES FOR VARIOUS PROPERTIESC 
C                  ARRAY ELEMENTS ARE: 1: THERMODYNAMIC PROPERTIES   C 
C                                      2: VISCOSITY                  C 
C                                      3: THERMAL CONDUCTIVITY       C 
C                                      4: DIELECTRIC CONSTANT        C 
C                                      5: REFRACTIVE INDEX           C 
C IPFLG   IA   O   RESULTS OF PROPERTY BOUNDARY CHECKS               C 
C IGFLG   I    I   WHETHER TO COMPUTE AND RETURN ONLY IDEAL GAS PROPSC 
C                  1=IDEAL GAS, 0=REAL FLUID                         C 
C NRI     I    I   NUMBER OF REFRACTIVE INDEX POINTS TO COMPUTE      C 
C WAVRI   RA   I   ARRAY OF WAVELENGTHS (IN MICROMETERS) AT WHICH TO C 
C                  COMPUTE REFRACTIVE INDEX                          C 
C RI      RA   O   RETURNED ARRAY OF REFRACTIVE INDICES              C 
C IRIFLG  IA   O   ARRAY OF RETURN FLAGS FOR REF. INDEX WAVELENGTHS  C 
C                  0     = OK                                        C 
C                  1( 1) = LARGER(SMALLER) THAN RECOMMENDED RANGE,   C 
C                          VALUE IS AN EXTRAPOLATION                 C 
C                  2( 2) = TOO LARGE(SMALL), BEYOND REASONABLE       C 
C                          EXTRAPOLATION RANGE. WILL STILL RETURN    C 
C                          COMPUTED NUMBER IF WITHIN RANGE WHERE CALCC 
C                          DOESN'T BLOW UP, OTHERWISE RETURNS ZERO.  C 
C                                                                    C 
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PSAT, TSAT:  Solve for vapor-liquid saturation (vapor-pressure) curve. 
 
      SUBROUTINE PSAT(TK, PMPA, RHOL, RHOV, IWORK, PROPR, IERR) 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
C                     *** PSAT ***                                   C 
C THIS ROUTINE COMPUTES THE COEXISTENCE PRESSURE (IN MPA) AT A       C 
C GIVEN TEMPERATURE (IN K).  IT ALSO RETURNS THE COEXISTING          C 
C DENSITIES.  IT CALLS PCOEX, WHICH WORKS IN REDUCED UNITS.          C 
C                                                                    C 
C ARGUMENT LIST:                                                     C 
C   NAME  TYPE I/O? EXPLANATION                                      C 
C ------ ---- ---- ------------------------------------------------  C 
C TK      R    I   TEMPERATURE, K                                    C 
C PMPA    R    O   COEXISTENCE PRESSURE, MPA                         C 
C RHOL    R    O   SATURATED LIQUID DENSITY, KG/M3                   C 
C RHOV    R    O   SATURATED VAPOR DENSITY, KG/M3                    C 
C IWORK   IA   -   INTEGER VECTOR FOR USE BY LOWER-LEVEL ROUTINES    C 
C PROPR   RA   -   VECTOR OF REDUCED PROPERTIES USED BY LOWER-LEVEL  C 
C                  ROUTINES                                          C 
C IERR    I    O   ERROR FLAG (FROM PCOEX)                           C 
C                  0 = SUCCESS                                       C 
C                  1 = TEMPERATURE OUT OF RANGE                      C 
C                  2 = UNABLE TO BRACKET (PROBABLY BECAUSE VERY CLOSEC 
C                     TO TC) RETURN VALUES FROM SATURATION EQUATIONS C 
C                  3 = UNABLE TO CONVERGE BOUNDED SOLUTION.  RETURN  C 
C                      LAST GUESS FOR SOLUTION                       C 
C                  4 = TEMPERATURE BELOW TRIPLE POINT BUT IN RANGE   C 
 
      SUBROUTINE TSAT(PMPA, TK, RHOL, RHOV, IWORK, PROPR, IERR) 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
C                     *** TSAT ***                                   C 
C THIS ROUTINE COMPUTES THE COEXISTENCE TEMPERATURE (IN K) AT A      C 
C GIVEN PRESSURE (IN MPA).  IT ALSO RETURNS THE COEXISTING           C 
C DENSITIES.  IT CALLS TCOEX, WHICH WORKS IN REDUCED UNITS           C 
C                                                                    C 
C ARGUMENT LIST:                                                     C 
C  NAME  TYPE I/O? EXPLANATION                                       C 
C ------ ---- ---- ------------------------------------------------  C 
C PMPA    R    I   PRESSURE, MPA                                     C 
C TK      R    O   COEXISTENCE TEMPERATURE, K                        C 
C RHOL    R    O   SATURATED LIQUID DENSITY, KG/M3                   C 
C RHOV    R    O   SATURATED VAPOR DENSITY, KG/M3                    C 
C IWORK   IA   -   INTEGER VECTOR FOR USE BY LOWER-LEVEL ROUTINES    C 
C PROPR   RA   -   VECTOR OF REDUCED PROPERTIES USED BY LOWER-LEVEL  C 
C                  ROUTINES                                          C 
C IERR    I    O   ERROR FLAG (FROM TCOEX)                           C 
C                  0 = SUCCESS                                       C 
C                  1 = PRESSURE OUT OF RANGE                         C 
C                  2 = UNABLE TO BRACKET (PROBABLY BECAUSE VERY CLOSEC 
C                      TO TC) RETURN VALUES FROM SATURATION EQUATIONSC 
C                  3 = UNABLE TO CONVERGE BOUNDED SOLUTION.  RETURN  C 
C                      LAST GUESS FOR SOLUTION                       C 
C                  4 = TEMPERATURE BELOW TRIPLE POINT BUT IN RANGE   C 
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PSUB, TSUB:  Solve for vapor-solid saturation (sublimation) curve. 
 
      SUBROUTINE PSUB(TK, PMPA, IERR) 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
C                     *** PSUB ***                                   C 
C THIS ROUTINE GIVES THE SUBLIMATION PRESSURE PMPA AS A FUNCTION OF  C 
C TEMPERATURE TK USING THE EQUATION OF WAGNER ET AL.  (J. PHYS.      C 
C CHEM. REF. DATA, TO BE SUBMITTED, 2008 IAPWS RELEASE)              C 
C                                                                    C 
C ARGUMENT LIST:                                                     C 
C  NAME  TYPE I/O? EXPLANATION                                       C 
C ------ ---- ---- ------------------------------------------------  C 
C TK      R    I   TEMPERATURE IN K                                  C 
C PMPA    R    O   SUBLIMATION PRESSURE IN MPA                       C 
C IERR    R    O   RETURN CODE:                                      C 
C                  0 = SUCCESS                                       C 
C                  1 = TEMPERATURE BELOW VALID RANGE (130 K)         C 
C                  2 = TEMPERATURE ABOVE VALID RANGE (273.16 K)      C 
C                  IF 1 OR 2, AN EXTRAPOLATION IS STILL RETURNED     C 
 
      SUBROUTINE TSUB(TK, PMPA, IERR) 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
C                     *** TSUB ***                                   C 
C THIS ROUTINE GIVES THE SUBLIMATION TEMPERATURE TK AS A FUNCTION OF C 
C PRESSURE PMPA USING THE EQUATION OF WAGNER ET AL.  (J. PHYS.       C 
C CHEM. REF. DATA, TO BE SUBMITTED, 2008 IAPWS RELEASE)              C 
C IT SOLVES BY ITERATIVELY CALLING PSUB.                             C 
C                                                                    C 
C ARGUMENT LIST:                                                     C 
C  NAME  TYPE I/O? EXPLANATION                                       C 
C ------ ---- ---- ------------------------------------------------  C 
C TK      R    O   SUBLIMATION TEMPERATURE IN K                      C 
C PMPA    R    I   PRESSURE IN MPA                                   C 
C IERR    R    O   RETURN CODE:                                      C 
C                  0 = SUCCESS                                       C 
C                  1 = PRESSURE BELOW VALID RANGE (TK=130 K)         C 
C                  2 = PRESSURE ABOVE VALID RANGE (TK=273.16 K)      C 
C                  IF 1 OR 2, 130 OR 273.16 IS RETURNED              C 
 
SURF:  Compute vapor-liquid surface tension at given temperature. 
 
      SUBROUTINE SURF(TK, SURFT, IERR) 
CCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC 
C                     *** SURF ***                                   C 
C THIS ROUTINE COMPUTES THE VAPOR/LIQUID SURFACE TENSION             C 
C OF WATER AT A GIVEN TEMPERATURE AND SATURATION CONDITIONS          C 
C ACCORDING TO THE SEPTEMBER 1994 IAPWS RELEASE ON THE SURFACE       C 
C TENSION OF ORDINARY WATER SUBSTANCE                                C 
C                                                                    C 
C ARGUMENT LIST:                                                     C 
C  NAME  TYPE I/O? EXPLANATION                                       C 
C                                                                    C 
C TK      R    I  TEMPERATURE IN KELVINS                             C 
C SURFT   R    O  SURFACE TENSION IN N/M                             C 
C IERR    I    O  RETURN CODE:                                       C 
C                 0 = SUCCESS                                        C 
C                 1 = TEMPERATURE BELOW LOWER LIMIT FOR SATURATION   C 
C                     CALCULATION, ZERO RETURNED                     C 
C                 2 = TEMPERATURE ABOVE CRITICAL POINT,ZERO RETURNED C 
C                 3 = 2 PHASE REGION EXTRAPOLATED BELOW TRIPLE POINT C 
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C.3 Example Program 

Below, we reprint a brief program that demonstrates how routines in INTPK might be called. This program 
accepts a temperature input and computes the vapor pressure along with the density, enthalpy, entropy, and 
refractive index of the coexisting liquid and vapor phases. 
      PROGRAM EXAM 
C 
C   SAMPLE PROGRAM ILLUSTRATING FINDING VAPOR PRESSURE AT A TEMPERATURE 
C   AND THEN FINDING SOME PROPERTIES OF COEXISTING VAPOR AND LIQUID 
C 
      IMPLICIT DOUBLE PRECISION (A-H,O-Z) 
      INCLUDE 'nprop.cmn' 
C   ALLOCATE ARRAYS FOR CALCULATIONS, PROPERTIES, AND ALSO BOUNDARY 
C   CHECKS PERFORMED UNDER PROPS 
      DIMENSION IWORK(NPROP), IWANT(NPROP), PROPR(NPROP), PROPSI(NPROP) 
      DIMENSION WAVRI(NRIMAX), RI(NRIMAX), IRIFLG(NRIMAX) 
      DIMENSION IPCHK(5), IPFLG(5) 
C 
      WRITE (*,111) 
  111 FORMAT (' ENTER TEMPERATURE IN KELVINS',/) 
      READ (*,*) TK 
C   CALL PSAT FOR SATURATION PRESSURE AND COEXISTING DENSITIES 
      CALL PSAT(TK, PVAP, RHOL, RHOV, IWORK, PROPR, IERR) 
      IF (IERR .NE. 1) THEN 
C 
C   CALL FOR PROPERTIES SEPARATELY FOR VAPOR AND LIQUID PHASES. 
C   TO SAVE TIME, ONLY REQUEST CALCULATIONS FOR ENTHALPY AND ENTROPY. 
C   SINCE THE VAPOR LIQUID BOUNDARY IS IN RANGE FOR ALL THE 
C   PROPERTY COMPUTATIONS, DO NOT CHECK BOUNDARIES.  ALSO NO NEED 
C   TO CHECK FOR 2 PHASE REGION 
C   ALSO GET REFRACTIVE INDICES AT 0.5893 MICROMETERS (SODIUM D LINE) 
C 
        DO 15 I=1,NPROP 
          IWANT(I) = 0 
   15   CONTINUE 
        IWANT(6) = 1 
        IWANT(7) = 1 
        DO 16 I=1,5 
          IPCHK(I) = 0 
   16   CONTINUE 
        NRI = 1 
        WAVRI(1) = 0.5893D0 
        CALL PROPS(IWANT, TK, RHOV, PROPSI, PROPR, 0, I2PH, 0, ISFLG, 
     >             0, ICFLG, IPCHK, IPFLG, 0, NRI, WAVRI, RI, IRIFLG) 
        HVAP = PROPSI(6) 
        SVAP = PROPSI(7) 
        RIVAP = RI(1) 
        CALL PROPS(IWANT, TK, RHOL, PROPSI, PROPR, 0, I2PH, 0, ISFLG, 
     >             0, ICFLG, IPCHK, IPFLG, 0, NRI, WAVRI, RI, IRIFLG) 
        HLIQ = PROPSI(6) 
        SLIQ = PROPSI(7) 
        RILIQ = RI(1) 
        WRITE(*,222) TK, PVAP, RHOL, RHOV, HLIQ, HVAP, SLIQ, SVAP, 
     >               RILIQ, RIVAP 
  222   FORMAT(' AT T(K) = ',F9.4,':',/,' PSAT(MPA) = ',G15.8,/, 
     >         ' LIQ. AND VAP. DENSITIES (KG/M3):  ',2(2X,G15.8),/, 
     >         ' LIQ. AND VAP. ENTHALPIES (KJ/KG): ',2(2X,G15.8),/, 
     >         ' LIQ. AND VAP. ENTROPIES (KJ/KG.K):',2(2X,G15.8),/ 
     >         ' LIQ. AND VAP. REFRACTIVE INDICES: ',2(2X,G15.8)) 
      ENDIF 
      STOP 
      END 
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Appendix D 
 

CONTACTS 

If you have comments or questions about the database, the Standard Reference Data Program would like to 
hear from you. You can rate the program and give feedback for future development at the following website: 

http://tsapps.nist.gov/msdsurvey/default.aspx?ID=1 

Also, if you should have any problems with the CDs, installation, or downloading the installation program, 
please contact: 

 Cindy McKneely 
 Standard Reference Data, MS 2300 
 National Institute of Standards and Technology 
 Gaithersburg, MD 20899-2300 
 (301) 975-2208 
 (301) 926-0416 (FAX) 
 Cindy.McKneely@nist.gov 

The scientific contact for the database is: 

 Allan H. Harvey 
 Applied Chemicals and Materials Division 
 National Institute of Standards and Technology 
 Boulder, CO 80305-3337 
 (303) 497-3555 
 allan.harvey@nist.gov 

http://tsapps.nist.gov/msdsurvey/default.aspx?ID=1
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